v Tabs3

Reliable Software. Trusted Service.

Billing PracticeMaster. Financial

Administrator Guide

|

Tabs3.com



Tabs3 Software Administrator Guide

Copyright © 2013-2015

Software Technology, Inc.
1621 Cushman Drive
Lincoln, NE 68512

(402) 423-1440
Tabs3.com

-
]

Tabs3, PracticeMaster, and the "pinwheel" symbol ( 1’) are registered trademarks of Software Technology, Inc.

Version 17 (January 06, 2015)



Tabs3 Software Administrator Guide

Table of Contents

Introduction ... 1
Purpose of Guide ... .. .. .. .. 1
Knowledge Base . ... ... ... ... . 1
Additional Resources _ ... .. ... il 1
Customer ServiceisImportant ... .. .. ... ... 1
Register the Software ... ... ... i 2
SettingUp theBasics ... . 3
Starting System Configuration ... ... . ... ... 3
SettingUp the Firm ... .. i 3
Setting Up Access Profiles ... .. . .. il 4
Setting Up Users ... .. . . e 7
Security OVerVieW . ... . .. e 9
Setting Up Groups ... . ... e 10
Defining theClient ID Format ... . ... ... ... 12
Setting Up Printers ... ... . . e, 13
Customizing Task Folders _ .. . . ... 15
Setting Up Tabs3 Billing .......... ... ... ... ... 17
Tabs3 Billing Customization ... ... ... ... 17
Startup Files .. ... e 19
Timekeeper Level ... ... . 19
Timekeeper . 20
CategoOrY .. 21
Transaction Code (Tcode) .. .. ... 21
Billing Frequency . ... ... il 23
Optional Files . ... . ... . 24
Clients and Contacts .. ... ... .. ... 24
Selectinga Transition Date ... ... . ... . ... ... 25
Entering Accounts Receivable Balances ... ... ... . ... ... 25
Method 1: Entering Balances viathe Client File ... _ ... ___._.__...._.....__. 26
Method 2: Entering Transactions & Running Final Statements ...._.... ... ... . .. 27
Method 3: Custom Conversion .. ... ... ... .. ... ......... 28




Tabs3 Software Administrator Guide

Examples for Entering A/RBalances ... ... ... . ... .. ...__............... 28
Entering Work-in-Process Balances ... ... ... ... . ... ... 29
Billing Rates .. il 30
Fee Compensation Rules . ... . ... . .. 31
Methods of Billing ... ... .. .. il 33
Statements ... ... 33
Setting Up the Statement Printer ... ... ... .. ... ...l 33

Setting Up PracticeMaster ... ... ... 35
Customization ... . ... e, 35
Using PracticeMaster without Tabs3 Billing ............. ... . ... ... ... .......... 36
Clientsand Contacts ... .. .. ... . ... ... i, 36

Contact Categories .. ... .. ... .. ... i, 36

Outlook Synchronization ... ... . ... 37
Areas of Practice ... ... ... 38
Calendars . ... ... 38

Calendar Codes . .......... ... ... 38

GrOUPS ... 39
Calendar Rights . ... ... . . 40
Convert to Fee Settings ... ... ... il 42
Document Management ... . 44

Setting Up Tabs3 Financial Software ... ... .. ... ... . 45
Tabs3 Trust Accounting Software ... ... ... ... 45

TAS Customization ... .. iiil.... 45

Startup Files ... ... e 46

Attorney File ... 46
Bank Account File ... ... ... .. 47
Firm Payee ... . . 48

Trust Accounts and Trust Transactions ... ... .. ... ... ................. 49

Trust Account Balances ... . .. ... ... il 49

Check FOrms e 50

Configuring Check Printers ___ ... .. . ... 51
Tabs3 Accounts Payable Software ... ... ... ... 52

APS Customization _ .. 52




Tabs3 Software Administrator Guide

Bank Account Information ... ... 53

Check Forms ... . il 54
Configuring Check Printers ___ .. ... 54

Tabs3 General Ledger Software ... ... . .. ...l 55
Cash Basis Accounting vs. Accrual Accounting ........... ... ... 55

General Ledger Clients _ ... ... ... 56

Journal Names ... o il 57

Departments .. ... . i, 57

Chart of Accounts . . ... .. 58

A Little Background About Accounts ... . ... . ... ... 59

Posting Beginning Balances ... ... ... ... ... 61

Determine Starting Date & PostingDate _....._......................... 61

Post Journal Entries for Starting Balances ........._ ... .. .. ... 62

Platinum & Tabs3 Connect ... .. ... . ... 64
Configuring HotBackup ... ... .. . il 64
Configuring Tabs3 Connect __ ... ... .. . ... 64
Configuring Advanced Features ... 65
Credit Card Processing ... ... ... ... il 65
Document Management ... .. ... 65
Taskbill .. 66
Administrative Maintenance ... ... 67
General Usage Tips .. ... ... i il 67

Exit the Software Before Turning Off the Computer ... ... . ... ... ..._.... 67

Active User List ... . il 67
Resetting Users _ ... ... il 67

Startup Options . ... .. ... . . 68
Month-End/Year-End Procedures ....... .. ... ... ...l 68
Backup Best Practices ... ... . ... ... 68
Integrity Check Programs . ... ... .. .. 69
Tracking Tools ... il 69

Verification Lists ... . 69




Tabs3 Software Administrator Guide

Log Files .. . il 70
Submit Log Files ... . . ... 70

History Tracking ... ... 71
How to Configure History Tracking ........ ... ... ... _..................... 71

Viewing the History File ... ... . .. 72

When the History File GetsToolarge _.......... . .. ... .. ................ 72
Miscellaneous Notes .. ... .. .. ... ... ... 73
ReSOUNCeS . . . 73
Guides & Quick Guides ... 73
Sample RepPOrts ... ... e 74
Training Videos _ ... ... il 74
Knowledge Base .. ... ... . il 74
Help .o 74
Technical Support . .. i 75
Tabs3 Resellers & Consultants ... ... ... ... ... 75

- v -



Tabs3 Software Administrator Guide

Introduction

Congratulations on choosing Tabs3 software! We are pleased to welcome you to the satisfied and
growing family of Tabs3 and PracticeMaster users. Our software is backed by our professional staff,
which has extensive experience in accounting, program development, and customer support. Our
goal is to provide law firms with the highest level of quality products and service. We are committed
to providing our customers with user-proven, reliable software.

Purpose of Guide

This Administrator Guide is a single comprehensive guide for setting up all of the software
including Tabs3 Billing, PracticeMaster, and the Tabs3 Financial Software, which consists of Tabs3
Accounts Payable Software (APS), Tabs3 General Ledger Software (GLS), and Tabs3 Trust Accounting
Software (TAS). This guide is written for the person who configures the software and performs
routine maintenance, typically the Office Administrator or Billing Manager.

A separate Installation Guide includes information for installing the software. The Installation
Guide is written for the person who installs the software and is responsible for IT.

Additional guides for separate software features are also available. All guides are available on our
Web site at:

Tabs3.com/support/docs.html

Knowledge Base
You may be referred to additional detailed information located in our Knowledge Base on the
Internet at:

support.tabs3.com

Additional Resources

A comprehensive list of all resources for Tabs3 software can be found on page 73.

Customer Service is Important

We understand that customer support is an important part of customer satisfaction. When you
purchase a Tabs3 software license, you have our assurance of customer service and product support.
Product support plays a key role in our customer service philosophy. Our Technical Support staff is
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dedicated to helping you get the most from the software by answering technical questions about
the product and how it works.

If you have a question or problem concerning the software, we recommend these steps:
1. Check the product documentation including the Help provided with the software. Often,

you'll find the answer to a question there.

2. Refer to our Knowledge Base on the Internet. Our Knowledge Base contains extensive
information on Error Troubleshooting, Networking & Windows Issues, “How To" Articles and
Product-Related Articles. Our Knowledge Base can be launched from the Help | Internet
Resources | Knowledge Base menu options in the software or found at:

support.Tabs3.com

3. Consult the reseller from whom you purchased the software license. If you can’t find the
answer in the product documentation, your reseller may be able to assist you.

4. Call our Technical Support Department at (402) 419-2210. Before you make the call, gather all
information pertaining to the problem. We will need to know the serial number of the
software, which can be found via the Help | About menus in the software.

Register the Software

The software must be registered in order to receive technical support and maintenance benefits.
Registering the software establishes you as the licensed user.

> To register the software

e From the Help menu, point to Internet Resources and select Register Software.
..Or...

e Go to Tabs3.com/register
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Setting Up the Basics

After installing the software, you need to set up your firm, access profiles, and users. Setting up
these files is performed using System Configuration.

Starting System Configuration

You can start the System Configuration software using one of the following methods.

Method Steps

Windows Start menu From the Windows Start menu, point to All Software | Tabs3 &
PracticeMaster | System Configuration.

Windows Desktop From the Desktop, click the System Configuration shortcut.
Tabs3 or PracticeMaster From Tabs3 or PracticeMaster, click the @ icon on the main

application bar.

Setting Up the Firm
The Firm Information program includes the firm's name, address, telephone, and other basic
information.

» To set up your firm information

1. From System Configuration, click the File menu, point to Open, and then select Firm.
2. The Firm Information window will be displayed.

3. Enter your firm information.

4. Click = to save the information.

5. Close the window.

Note: Firm information can be changed at any time. Refer to the Changing Firm Information Help
topic for complete details regarding other areas in the software that may also need to be changed.
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Firm Information EI@

Firm Mame and Address

Firrn Mame:
Mote: The Firm Mame will be printed as a heading on reports

Firm Address: 1621 Cushman Drive

Lincoln, NE B8512

Mote: The Addiezs will be printed on 1093 forms.

Additional Information

Ctate (spelled out)  Mebraska
County: Lancaster
Firm's Federal D 4 12-3456789

Mote: The Federal I # will be printed on 1099 forms.

Contact Information

Firm Phone: 402-419-2200
Firm Fax: A02-413-2201
Firm E -rnail: bilingi=jensenmartinlaw.com
Firm \/eb Site: vl enzeni artinlaw. com

Figure 1, Firm Information window

Setting Up Access Profiles

Access profiles are used to designate which programs and functions are accessible by the users who
are associated with the access profile. You can define as many access profiles as you like. Rights for
each access profile can be as broad or limited as needed. For example, you may want to have an
access profile where users can view calendar information but not have access to billing or
accounting information. You may want to have an access profile that limits who has access to the
General Ledger software.

When you set up users, you will assign one or more access profiles to each user.
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Access Profile

E@ E Access Profile

[E=N el =)

System Actviy |Tabs3 [PM__ | GLS | TAS | APS |

| System Activty | Tabs3 [PM_ [GLs [Tas [aps |

Access ID: BILLING =

Access Name: [0
System Corfiguration Access

ser Corfiguration roup Corfiguration
[#] User Carf [¥] Group Corf
[ Tahs3 Connect Access and Settings

[ Check for Software Updates

Back Up/Restore

Back Up Data Files Restore Data Files

System Options
Fim Information Display Active User List
[T Log OF Users [T 5QL Access to System Config Files

Access ID: BILLING| <

Access Name:  Biling

-
Fee. Cost, Payment & Client Funds Transactions [
Timekeeper, Category & Transaction Code Information/Misc. Desc. =—
Bill. Freg./Location/Task Code/Dial Phone
Statement Preparation
Statements/Statement Setun

Functions

.
Add Cliert Yes F
Change Client Yes =
Delete Client No
Browse Client Notes Yes i
Edit Client Notes Yes
Browse Fee Compensation Rules Yes
Edit Fee Compensation Rules Yes ==
Selected Functions Al Functions Entire System
[ Allow ] [ Disallow ] [ Allow ] [ Disallow ] [ Alow ] [ Disallow ]

Figure 2, Access Profiles - System Activity tab

Manager Access Profile

» To add an Access Profile

Figure 3, Access Profiles - Tabs3 tab

A predefined Manager access profile is provided with the
software. Users who are associated with the manager
access profile have all rights to all functions in all software.
The Manager access profile cannot be edited or deleted.
Additionally, there are certain tasks that can only be
performed by managers, such as resetting users, adding or
deleting users, editing other users, and more. A complete
list of manager exclusive tasks can be found in the
Manager Access Profile topic in Help.

Best Practice: We recommend limiting the number of
users who are given manager rights.

1. From System Configuration, click the File menu, point to Open, and then select Access

Profile.

2. The Access Profile window will be displayed.
a. Inthe Access ID field, enter a shortcut name using up to 8 characters.
b. Inthe Access Name field, enter up to 30 characters for the full name.
¢. Under System Options, select which functions, if any, that members of this access
profile can access in System Configuration.
d. Under Back Up/Restore, select which functions, if any, this members of this access
profile can access in any of the software.
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3. Click the Tabs3 tab at the top of the window.

a. The first group of functions, Client Information is highlighted. Under Functions,
select which functions members of this access profile can access. You can use the
Allow and Delete buttons at the bottom of the window to easily select multiple rights
at the same time.

b. Select the next group of functions, Fee, Cost, Payment & Client Funds Transactions,
and set the rights as desired.

¢. Continue with selecting each group of functions and setting the rights as desired.

4. Click each of the tabs at the top of the window and set the rights as desired.

5. Click to save the information.

6. Click L' if you want to add additional access profiles.

More Info: A complete listing of the detail access rights for all systems can be found in Knowledge
Base article R11540, "Access Rights" (support.Tabs3.com).
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Setting Up Users

You will need to set up a user ID for each | [ yser configuration

(Figure 4).

= R[>
user who will be using the software .
Logon Infarmation
User ID: LI = Logan User
Password: sesnenee [] Inactive
Confirm Password:  esssssse Feset Profile

» To add a User ID

User Information

Uszer Mame: Michael L. Jensen
Initials: ML

Phone Mumber:  402-423-1440

Fax Mumber:

E-mail &ddress: mienzeni@jensenmartincom

Optianz

Calars used for Practicetaster Calendar entries: User Text Calar 2

Setwiew calendar access rights for this uzer: Calendar Rights

[ Dizable Autofill for all lookup fields
Allow CompuLaw D ates to be generated for this user in Practicet aster

[ &llow access via Tabs3 Conmect Tabs3 Connect Settings

Curmently Azsigned Access Profiles [max 5):

"e Access D Access Name -
MaNAGER [&ll Rights to All Programs] M
APS/GLS/TAS usage M
BILLING
DATA Tabs3 Data Entry -

Azsign Tabs3/Practicet aster Timekeepers

v T Mo, Initialz Mame

Fobert 0. Burns

Figure 4, User Configuration window

1. From System Configuration, click the File menu, point to Open, and then select Users.

2. Click the L" button to add a new record.

3. The User Configuration window will be displayed.

a. Inthe User ID field, enter a unique shortcut name of up to 8 characters. You can use

letters, numbers, and the underscore character.

b. Enter a password in the Password and Confirm Password fields. Passwords are
forced to uppercase letters. Up to 20 characters, numbers, or symbols can be used.




Tabs3 Software Administrator Guide

¢. Under User Information, enter the remaining user information.
d. Under Options, select the desired options.

More Info: Information regarding Calendar Rights can be found on page 40.
Information regarding Tabs3 Connect can be found on page 64.

e. Under Currently Assigned Access Profiles, select which access profile(s) the user
will belong to.

More Info: Additional information regarding assigning Tabs3/PracticeMaster
Timekeepers can be found on page 7.

4. Click ECH# to save the information.

5. Click L' if you want to add additional users.

Note: Users can change their own User Name, Initials, Password, E-mail Address, Calendar Colors
and Calendar Rights if they belong to an access profile that has been assigned access rights to
User Configuration. However, only managers can change access profile assignments, timekeeper
assignments, or add new users to the user file.

Blank User ID A predefined User ID is provided with the software. This
user is named (BLANK) and is assigned to the manager

profile.

Best Practice: Once you have set up another manager
user, we recommend deleting the (BLANK) User ID in
order to preserve system security.

Set up your shared resources as users for scheduling
purposes in the PracticeMaster Calendar. Resources that
you may want to set up as users include rooms, projectors,
easels, laptops, tablets, company vehicles, etc. For
example, set up each conference room as a user. Then,
when you need to schedule a meeting in that room, select
each attendee and the room to easily find an open
timeslot.

Shared Resources
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Outlook Integration A separate program for configuring Outlook integration
with PracticeMaster for each user is available in
Maintenance | Integration | Outlook Synchronization.
Additional information can be found in Knowledge Base
article R11400, Outlook Integration Guide.

Security Overview

Tabs3 software offers multiple layers of security.

Access Profiles Access profiles are created to assign rights to the various
software systems and menu options (page 4).

User ID User IDs are created for each person who will have access
to the software. When defining User IDs, you will also
assign one or more access profiles to which they belong.

Password Passwords are assigned to User IDs.

Secure Clients Clients can be set up as secure clients, thereby allowing
you to specify exactly which User IDs have access to each
secure client. Clients who are designated as secure clients
cannot be seen by users unless the User ID being used has
manager rights or has been assigned access to the secure
client. Clients marked as secure are secure in Tabs3 Billing,
PracticeMaster, and Tabs3 Trust Accounting Software.

Note: When a client is designated as secure, the client's
contact information is stored in the Client file instead of
the Contact file. This is because contact information is
viewable by all users with browse rights to the Contact
file.

Timekeeper You can set up a User ID so the user has access to a
particular timekeeper's transactions but does not have
access to other timekeeper's transactions. This is useful in
situations where you have an employee who is responsible
for a particular timekeeper but you want to restrict the
employee from accessing any work performed by other
timekeepers in the firm. Tabs3 Billing timekeepers can be
assigned to a User ID by selecting the Assign
Tabs3/PracticeMaster Timekeepers check box in System
Configuration.
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Calendar Security

Calendar records in PracticeMaster can be designated as
public or private. All public calendar entries can be viewed
by all users. Users can designate which users will have:

e edit rights to their public calendar records;
e browse rights to their private calendar records; and

e edit rights to their private calendar records.

These rights allow the firm and users to implement
sophisticated access rights for their calendar entries. For
example, a timekeeper can designate that only his
secretary and partner have edit rights for his public
calendar records, only his secretary has browse rights to
his private calendar records and nobody has edit rights to
his private calendar records. PracticeMaster calendar
rights are implemented via the Calendar Rights button in
the User Configuration program of System Configuration.

More Info: Additional information regarding security can be found in the following Knowledge
Base articles at support.Tabs3.com:

e Knowledge Base article R11540, "Access Rights”
e Knowledge Base article R11459, "Ethical Walls in Tabs3 Software"

Setting Up Groups

Once users have been defined, you can set up et Tigheten =N = =

groups. Groups are composed of various users
primarily for PracticeMaster calendaring,
scheduling, filtering, and eNote purposes.

Group |D: ANDERSOM -

Group Mame;  Anderson's Staff

Users in the Group I}

d User [D User Mame -
CATHY Cathleen Trudore
CHERYL Cheryl Bradley =
DAN Daniel H. Brady 4

Jagon |. Masterson
JEN Jennifer &. Moonan

JFP Jimmy P. Praum
F.endra |. Michaels
Michael L. Jensen
Paula &nin b artin
P Uszer
ROBERT Fobert 0. Burns

m Fonald P. &nderson -

Figure 5, Group Configuration window

-10 -
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» To add a group

1. From System Configuration, click the File menu, point to Open, and then select Group.

2. The Group Configuration window will be displayed.
a. Inthe Group ID field, enter an 8-character group ID.
b. In the Group Name field, enter the name of the group.
¢. Under Users in the Group, click the check mark column for each user whois a
member of the group.

Click EI to save the information.

4. Close the window.

Tip: Groups are optional and can be defined later. Think about scheduling purposes when

setting up groups. You can also look at the various groups you use for email purposes as a
starting point. For example, you may want to define a separate group for each department,
a group for all partners and group for all staff who work with a particular attorney.

-11 -



Tabs3 Software Administrator Guide

Defining the Client ID Format

Once you have defined firm information, access profiles, users, and groups, you can configure
printers, as discussed on page 13. However, when you start the software to configure the printers,
the Customization window will be displayed. You must save the Customization information before
you can use the software. Although this guide includes detailed information regarding
Customization for each of the software products in later sections, there is one area in Customization
that is common to Tabs3 Billing, PracticeMaster, and Trust Accounting (TAS), and that is the
configuration of the Client ID. The Client ID represents your client numbering scheme. This section
discusses how the Client ID format is defined.

Two fields named Key Type and Decimal Places are used to determine your client numbering
scheme. These fields are typically defined in Tabs3 Customization first. Once defined in Tabs3
Customization, the information is mirrored to PracticeMaster Customization and TAS Customization.

There are three different Key Types: Numeric, Mixed, or Alpha. All Client IDs can have a maximum of
12 characters including an optional decimal point. Typically the client portion of the Client ID is left
of the decimal and the matter number is right of the decimal. The 12-character limit for Client IDs
includes the portion on the left side of the decimal, the portion on the right side of the decimal, and
the decimal itself.

The Decimal Places determines the number of digits for the matter position. Many firms will use 2 or
3 to start with.

Key Type Description
Numeric A Numeric Key Type allows only numbers in the client and matter portions of the
Client ID. 123.45, 20.001, and 5000.110701 are all examples of a Numeric Client ID.
Mixed A Mixed Key Type allows alpha or numeric characters in the client portion of the

Client ID but only allows numeric characters in the matter portion of the ID. ABC.01,
DE12.004, and Smith.110801 are all examples of a Mixed Key Type.

Alpha An Alpha Key Type allows both alpha and numeric characters in the client and
matter portions of the Client ID. ABC.DE and FG12.H34 are examples of an Alpha Key

Type.
There are advantages to using a Numeric Key Type. When using a Numeric Key Type, the primary

advantage is that Tabs3 can automatically assign new Client IDs and Matter IDs. When using a Mixed
Key Type, Tabs3 can automatically assign new Matter IDs, but not new Client IDs.

Best Practice: If you are not sure which Key Type to use, we recommend using a Numeric Key
Type.

You will need to define your Key Type and Decimal Places before using Tabs3 Billing,
PracticeMaster, and Trust Accounting.

-12 -
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Setting Up Printers

Each workstation that uses Tabs3 software can define its own default printer. This printer is used for
printing reports.

» To define the default report printer

1. From the File menu, select Print Setup.
2. The Printer Setup window will open.

3. In the Printer field, select the desired default printer.

Tip: Click the Page Setup and Advanced Printing Features to view the different options available.

In addition to the default report printer, each workstation maintains a default Tabs3 Billing final
statement printer, a default Tabs3 Billing draft statement printer, a default APS check printer, and a
default TAS check printer. These printers are defined when using those features. Additional print
options for printing statements and checks are available when accessing the Print Setup program in
Tabs3 Billing, APS, and TAS.

(WE || ( Printer Setup | ——
Frinter: [ Brother HL22700W -] Printer. | Brother HL-22700w/ -]
[ Fage Setup ] [StatementSetup] [ Advanced Printing Features ] [ Fage Setup ] Advanced Printing Features

Font Selection Mods Font Selection Mode

Printer Setup

@ Automatic ) Manual () Automatic @ Marual

Automatic Fant Selection Setup Automatic Fant Selection Setup

Ease Font: Aiial

anual Font Selection Setup anual Font Selection Setup
Select 0-40 Colurns 10 pt Avial Select
Select 41 - 80 Calumng 10 pt Avial Select
Select 21 -132 Columns 10 pt Arial Select
Select 133-160 Colurnng 10 pt Arial Select
Select 167 - 255 Colurnng 10 pt Arial Select

[ oK ][ Cancel ] [ Help ] [ oK ][ Cancel ] [ Help ]

Figure 6, Printer Setup with Automatic Font Selection Figure 7, Printer Setup with Manual Font Selection

-13 -
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Marging
Left:

Right; 0.250

Printer Dffzet Adjustment

Left: 0.000 Top:

[ Canecel ]

APS Check Printer Setuy
Spell Dut Check Amount Print Mema on Checks
Check Mumbers Preprinted on Checl: (Oniy for Check Lagout L1572)

[ Print Check Number
[ Print Duplicate Stub
[ Print Yendor # on Check Stub

Paper; Letter -
Sace
[ Ok ] [ Cancel ] l Help ]

1 [ Advanced Printing Fe

Allow Variable Font Sizes and Styles
Use Commas in all Mumeric Fields

Fant Size Adjustment ;100 =

Nl Gray Test and Lines Gray Shade Density
Preview Negative Numbers in Red Light 13% Diark
[ Print Negative Numbers in Red
[ Dptimize for Print to File - ﬂ
Remove Formatting when 5aving to Excel
Foater Gray Test and Line Dengity
[] Print Fonter Light 0% Dark
Frint User Initials
Print Horizontal Ruling Line ﬂ

[ oK l[ Cancel ][ Drefault ][ Help ]

Figure 9, Advanced Printing Features

y f——
APS Check Printer Setup for Brot

HL-22700W on 192.168.200.57

Spell Dut Check Amount Print Memo on Checks
Check Mumbers Preprinted on Check, (O for Check Layout L1572)
[T Print Check Number

[T Print Duplicate Stub

[7] Print Yendor # on Check Stub

Paper; Letter -
[ Ok ] [ Cancel l [ Help ]

Figure 10, APS Check Printer Setup

Figure 11, TAS Check Printer Setup

More Info: Complete details regarding print options can be found in Help.

-14-
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Customizing Task Folders

Task Folders are used to navigate the software. The following figures are examples of the Main Task

Folders in each Tabs3 Software program.

===

- Task Folders - Jensen, Martin & Anderson, P.C. [[= " |5 | | \ Tesk Folders - Jensen, Martin & Anderson, P.C.
Accounts Receivable | Reports | Month-End | Integration | Uiities/Maintenance | Setup | Setup | Reports Files |
Man | Ciet | Transactions | Statement Prepamtion |  Statements Main | Cient | Calendar | Documents | Search | Integration | Maintenancs

2 =\

Clignt Cost Payment Clignt hatter Manager Joumal Conflict Search

9 2 B :
Client Manager Contact Recap of Generate “weekly Calendar Document Daocument Contact Search

Hours Report Statements Management Checkout List
Summary Tap Client Timekesper Clienk Inactivity Active Alamns Tirner Process Timer Exit
A/R Report Report Realization Report Records
@ Run ) Customize @ Run ) Customize

Figure 12, Tabs3 Main Task Folder

Figure 13, PracticeMaster Main Task Folder

= fE]

==

\_ Task Folders ===

\_ Task Folders - Jensen, Martin & Anderson, P.C.

Main | Trust Accounts | Checks/Depesits | Reperis [ 1039 | Uiities/Maintenance [ Setup |
~ o \ i
& ¢
Trust Accounts Trust Transactions Payees Print Checks Chart of Accounts Joumnal Entries General Ledger Acsount
Information
by
Check Register by Check. Register by Check Reqister by Client Trust Trial Balance Balance Sheet Incame Reconciliation
Trust Account Check Number Payee Ledger Statement eports
Bank Account Deposit Slips FRieconcilistion Budget Report
Balance
@ Run (@) Customize @ Run (@) Customize

Main | Chart of Accounts | Joumal Entries [ Reperts | Integration [ Utiities/Maintenance | Setup |

Figure 14, Trust Accounting Main Task Folder

Figure 15, General Ledger Main Task Folder

\_ Task Folders - Jensen, Martin & Anderson, P.C. = =R===
1099 | Morth/Year-End | Utiities | Setup |
Main | Vendor |  iwveices | Checks |  Repons
?‘.
[==]
Wendor Invoice / Check Register Print Checks
Manusl Checks
Fre-Check Cash Requiements tiged Unpaid Post Checks
Register epo Inveice Report

N L

Figure 16, Accounts Payable Main Task Folder

-15-
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You can customize the Main Task Folder of each product to include the most frequently used
programs.

» To customize the Main Task Folder

1. From the Main Task Folder, click the Customize option in the lower right corner.

2. Next, click the icon you want to change.
a. The Main Task Folder Customization window will be opened.
b. Select the item you want shown in that position.
c. Click OK.

3. Repeat step 2 for any other icons you want to change.

4. When finished customizing the various icon positions, click the Run option in the lower right
corner.
e Click Yes to confirm you want to save the changes.

Each user can customize their own icons.

-16 -
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Setting Up Tabs3 Billing

This chapter includes the information you need to start using Tabs3 Billing.

Tabs3 Billing Customization

The first time you start Tabs3 Billing after installing the software, the Customization window will be
opened. The Customization window consists of several tabs. There are a few fields that must be set
before proceeding. Complete details regarding the fields on each tab can be found in Help.

§ Customization E=3 E=l | & Customization [E=8 E=R =S
Main | Cther Systems | Options | Rates | Client Defauts | Merchant Services | [ Main_[ Other Systems | Oetions | Rates | Client Defaults | Merchant Services |
Key Type:  |Numeric 12345 2 Aging Perods
7 b
Frst orth of Repating Year: | Janory Hof Periods: B Period 1 30 Period 2 60 Period 3: 90

Profession Customization Period 4 120 Period 5: 180

Cliert Labe!: | SHEEIN Timekeeper Label:  TIMEKEEPER

Timer Options
Verffication Lists Statement Numbering! Minimum: 010 Incremert:  0.10
Create List for Fess

Create List for Costs
Create List for Payments

[¥] Create List for Client Funds Client Funds
[T Allow deletion of verfication lists without printing Automatic Payment Teodss: Fee - B -
Email Statemerts Method Adv - -
@) Outlook
© smTP

[ Include fund balance on statements for clients with orlly a fund balance

[ Include clients with only a fund balance on WIP reports  Billing Increment:

Figure 17, Tabs3 Customization - Main tab Figure 18, Tabs3 Customization - Options tab

{8 Customization

=8 E=R == & Customization

= E=0
Main | Other Systems | Options | Rates | Client Defauts | Merchant Services | [ Main_[ Other Systems | Options | Rates | Client Defaults | Merchant Services

Sales T

eles e [7] Progress Biling Receipt Allocation by Invoice

7] Tae Services [] Tax Expenses ] Tae Advances - [ Non ilable

Rate 1:  12.0000 Rate 2. 15.0000 Rate 3:  18.0000 7181l On Demand 7] Task Based Biing Clert

Rate 4: 0.0000 Rate 5: 0.0000 Rate 6: 0.0000 [F] Change Discount Type ta None after statement updated

Rate 7 10.0000 Rate 3: 0.0000 Rate 3 0.0000

picthecto #eob (1 Oldest FinChg, Okdst Advs, Oldest Exps, Ot Fee -
Finance Charge
N Statemert Delivery Method:

[7] Assess Finance Charge Minimum Amourt 0.00 =
[ Subect o Frncn Charm (51 Mk At Cover Sttement Elcontine Maters

Rate 1 18.00 Rate 2 1200 Rate 3 0.00 S Tax

Rate 4 0.00 Rate 5 0.00

Fes: [0-Nontaable | Eo: [0-Nontamble v| Adv: 0-Nortaxable v

Finance Charge
[] Assess Finance Charge

0 First

Figure 19, Tabs3 Customization - Rates tab Figure 20, Tabs3 Customization -

Client Defaults tab
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» Configuring the Tabs3 Customization Window

1. Start Tabs3 Billing. The Customization window will be opened automatically. (Note: If the
Customization window does not open automatically, use the Utilities | Customization menu
to open the window.)

2. On the Main tab:

a. Specify the desired Key Type and Decimal Places as described above.

b. Specify the First Month of Reporting Year field. Most firms use January, but some
firms have a fiscal year that starts with a different month. (Note: This month is
different than the current reporting month.)

c. If you will be e-mailing Billing statements, select which E-mail Statements Method
will be used. The default is Outlook and can be changed later as desired. (More Info:
More information can be found in Help. A detailed comparison can be found in
Knowledge Base article R11409 - Comparing Outlook vs. SMTP for E-mail
Statements.)

3. On the Options tab:
a. Specify whether you want statements numbered at the firm or client level in the
Statement Numbering field. (Note: We recommend numbering at the firm level so
you can easily search by statement number when entering payments.)

4. On the Rates tab:
a. If your state requires you to charge sales tax on services, expenses, or advances,
select the corresponding check box and enter the tax rate in the Rate 1 field.
b. If you would like to charge finance charge on past due balances, select the
corresponding check boxes and enter the annual rate in the Rate 1 field (e.g., enter
12.00 if you charge an annual finance charge of 12% per year).

5. On the Client Defaults tab:
a. Specify the defaults that will be used when adding a new client.
b. If assessing sales tax, under the Sales Tax section, select the default sales tax rate.
c. If assessing finance charge, select the Assess Finance Charge check box, the Rate,
and the number of Days past due before the finance charge will be assessed.

6. Click E_j to save the changes, then close Customization.

Note: If the Customization window was previously saved, the window will not be opened
automatically. Once Customization is saved, the Key Type, Decimal Places, and First Month of
Reporting Year fields will be dimmed and must be changed using the Change Key Type or Change
Beginning Reporting Month programs.

More Info: Detailed information regarding Sales Tax and Finance Charge can be found in Help.
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Startup Files

Before using Tabs3 Billing, you need to set up the following startup files:

Timekeeper Level
Timekeeper

Category

Transaction Code (Tcode)
Billing Frequency
Optional Files

The following includes information on what information is stored in each of the startup files, as well
as step-by-step procedures for adding a record.

Note: If Starter Data was included when the software was installed, the above startup files will
already have data. You can review the contents of the separate files and edit as desired. At a
minimum, you need to enter your timekeeper information.

More Info: Detailed information regarding copying, changing, deleting, or renumbering records
can be found in the Help.

TAS Note: If you receive the "TAS is installed and must be configured before continuing” message,
you must configure Tabs3 Trust Accounting before continuing. Instructions for configuring TAS
can be found on page 45. Once you've configured TAS, return to this section. Make sure the Key
Type and Decimal Places is the same for Tabs3 Billing and Tabs3 Trust Accounting.

Timekeeper Level

Timekeeper levels are used for grouping | [ wiscellaneous o =
Slmllar types Of tlmekeepers' YOU can ‘ Timekeeper I Category I Tcode | Misc Desc | Bill Freq I Location I Task Cude‘
optionally classify timekeepers by user
defined levels for purposes of default Level 1- [Sormor Pt
billing rates, productivity reports and fee Level 2: Partner
summaries on statements. Examples of Level 3: Associate

@ Timekeeper Levels () Cost Types () Task Code Sets

timekeeper levels include senior partner, Level 4: Paralegal
. Level 5: S
partner, associate, paralegal, law clerk, vel 3 | Socretay

ff U 9 . k Level 6: Law Clerc
secretary, staff, etc. Up to 9 timekeeper R

levels can be defined. Each timekeeper Level 8:
level can have a 20-character Level
description. P i PR

Figure 21, Timekeeper Levels
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» To add a Timekeeper Level

In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.

Click the Misc Desc tab.

1
2
3. The Timekeeper Levels option is selected by default.
4

Enter the desired timekeeper levels.

Timekeeper

Timekeepers are different than users.
Users represent anyone who uses the
software, or a resource that needs to be
scheduled, such as a particular
conference room. Tabs3 Billing refers to
a timekeeper as any person whose time
is entered and/or billed, such as
attorneys, accountants, clerks,
paralegals, secretaries, etc.

Each timekeeper is assigned a
timekeeper number, name, initials,
timekeeper level classification, and up to
six hourly billing rates. Rate 1 is usually
designated as the normal billing rate for
most clients. Timekeepers can be marked
as inactive, which prevents fees and
costs from being entered for them.

» To add a Timekeeper

E Miscellaneous EI@

Timekesper |Ca‘tegory I Tcode | Misc Desc I Bill Freq I Location I Task Code‘
Timekeeper: 1 - [ Inactive
Name: Michael L. Jensen
Initials: MLJ Level:

Rates

Effective Date of New Rates: mm/ddfyyyy  ~
Houry Rate 1: 250.00 New Rate 1: 0.00
Houry Rate 2: 275.00 New Rate 2: 0.00
Houry Rate 3: 200.00 New Rate 3: 0.00
Houry Rate 4: 200.00 New Rate 4: 0.00
Houry Rate 5: 225.00 New Rate 5 0.00
Houry Rate &: 0.00 New Rate &: 0.00
- S— P .

Figure 22, Timekeeper

1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.

2. By default, the Timekeeper tab is selected. Click L' on the toolbar.

3. You can accept the automatically assigned timekeeper number or specify a different
timekeeper number. The automatically assigned timekeeper number defaults to the first

available timekeeper number.

4. Enter the remaining information for the timekeeper.

. .
5. Click BC¥ on the toolbar to save the new timekeeper.
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Category

A category is an area of practice. Miscellaneous =R
Categories are used to classify fee

Timekeeper | Category |chde | Misc Desc I Bill Freq I Location I Task Code‘

services into related groups for reporting Categoy: 60 -

purposes in Tabs3 Billing. Examples of

categories include Personal Injury, Description: | ESECIIRREIEl

Workers' Compensation, Real Estate, Task Based Biling Code Set: [L- Liigation Code Set -

Family Law, Pro Bono, Consulting,

Individual Tax, Corporate Tax, Audit, etc. - . gl S

Figure 23, Category

Each category is assigned a number and a description of up to 30 characters.

» To add a Category

1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.

2. Click the Category tab.

3. Click [_I on the toolbar. You can accept the automatically assigned category number or
specify a different category number. The automatically assigned category number defaults to
the first available category number.

4. After specifying the category number, enter the description and optional Task Based Billing
Code Set for the category.

5. Click E on the toolbar to save the new category.

Transaction Code (Tcode)

The term transaction code refers to the types of activities or services performed that relate to fees
and costs charged to clients and the resulting payments made by the client. Transaction codes are
also referred to as tcodes. Transactions are classified as fees, costs, payments, and client funds
transactions. Examples of fee transactions include office conference, telephone conference, review
correspondence, prepare motions, etc.

Tabs3 Billing classifies costs as either advances or expenses. Cost advances are "out of pocket” costs
that are incurred by the firm on behalf of the client. Cost advances are often used to reflect “hard”
costs or "direct” costs. Examples of cost advances are witness fees, medical costs, filing fees, etc.
Client expenses, on the other hand, are costs incurred by the firm without a direct cash outlay.
Expenses are considered “soft” costs or “indirect” costs. Examples of client expenses are photocopy
expenses, documentation preparation, per diems, etc. In addition to classifying costs as expenses or
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advances, Tabs3 Billing also gives you the ability to further categorize expenses and advances by
Cost Type.

Up to 999 transaction codes can be defined. Each transaction code is assigned a number, an
abbreviation (Alpha Code) and a default description. Up to 1,000 characters are allowed in the
default description; however, additional text can be added when fees and costs are entered. Each
transaction code is designated as a fee, expense or cost advance transaction (i.e., the Trans. Type
field) and also has a designated Type of 0-9. The Type is used to specify how Tabs3 Billing will treat a
transaction. A Type 0 (normal) transaction code will be the most frequently used transaction code
type. It represents a normal transaction such as fee, expense and advance charges. Types 1 through 3
designate the transaction as a regular, fee or cost payment, respectively. A Type 4 transaction code is
“description only” and will not allow an amount or number of hours to be entered. Type 5
transactions are miscellaneous transactions that are used for making a fee or cost entry when there is
no predefined description that fits your needs or to print the transaction code as a separate item
when subtotaling. A Type 6 transaction code is set aside specifically for progress fees. Types 7 and 8
are not used.

Best Practice: Tabs3 Billing ships with a default set of transaction codes in the starter data. You
can use these standard transaction codes until you decide what other transaction codes your firm
requires. Alternatively, you can get started by defining just three transaction codes: one Type 0
transaction code for fees; another Type 0 transaction code for expenses; and one Type 1
transaction code for payments.

-
E Miscellaneous EI@

‘ Timekeeper | Ca‘legary| Tcode | Misc Desc I Bill Freq I Location I Task Code|

Teode: " - Alpha Code: =

0 - Miscellaneous

Description:  |Court appearance -

Sl

Bil Code: [0 Eillable / Privtable - [F] Charge Sales Tax
Amourt: 0.00 Effective Date of New Rate: mm/ddAyyy  —
Rate 0.000 New Rate: 0.000

AR T e i I e T 8
Figure 24, Tcode
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» To add a Transaction Code

1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.

2. Click the Tcode tab.

3. Click L' on the toolbar. You can accept the automatically assigned tcode number or specify
a different tcode number. The automatically assigned tcode number defaults to the first
available tcode number.

4. After specifying the tcode number, enter the remaining information for the transaction code.

5. Click &8 on the toolbar to save the new transaction code.

Billing Frequency

Billing frequencies are used by Tabs3 Billing to classify clients for billing purposes. Each billing
frequency consists of an 8-character Billing Frequency ID, a single character for reporting purposes,
and a description of up to 40 characters. For example, if your firm bills all of its clients on the same
day once a month, then you only need to define one billing frequency. You might call it "Monthly",
give it a description of "Monthly Billing Clients", and a Report Character of "M". Other billing
frequency examples include quarterly billing frequencies, on demand clients, contingency clients,
bi-monthly frequencies, etc.

Miscellanecus EI@
| Location I Task Code I GLS Integration Setup |
Timekeeper | Categoy |  Tcode |  MscDese |  BilFreg

Billing Frequency 10:  Monthly b

Description [Morthly Clients}
Report Character: M

Use this Biling Frequency as the default for new Clients

T et e T e T e e et AT T alP 1
Figure 25, Billing Frequency

» To add a Billing Frequency

1. From the Tabs3 Billing Task Folders, click the Setup tab.
2. Click the Billing Frequency Descriptions icon.

3. Enter the following information on the Bill Freq tab:
a. Inthe Billing Frequency ID, enter up to 8 characters to identify the billing frequency.

b. In the Description field, enter up to 40 characters to describe the billing frequency.
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c. Inthe Report Character field, enter a single character to identify the billing
frequency on reports, usually a letter from A to Z.

4. Click EI on the toolbar to save the billing frequency.

Optional Files
The following table includes a list of optional files that your firm may be interested in defining.
Detailed information regarding these files can be found in Help.

Best Practice: Tabs3 Billing ships with a default set of cost types, task code sets, and task codes.
You can use this default information until you decide whether your firm will be using these files.

File Name Task Folder Location Description
Location Setup | Location Define locations for firms with offices in separate
locations. Reports and statements can be
generated for clients assigned to specific

locations.

Cost Types Setup | Cost Type Define optional cost types for grouping similar
types of costs for reporting purposes.

Task Code Sets Setup | Task Code Sets Task code sets are used in conjunction with task

based billing. Use this option to modify the name
of each set of task codes.

Task Codes Setup | Task Codes Define Phase/Task codes, Activity codes, and
Expense code for task based billing purposes.

Clients and Contacts

Once the startup files have been defined, you can enter clients and contacts. Contact records store
address, phone and e-mail information. Separate contact records can be maintained for
organizations and individuals. When you have a client that is an organization, you can define a
contact record for the organization as well as separate contact records for each person associated
with the organization. Maintaining separate contact records makes it possible to synchronize all of
your contacts and clients in PracticeMaster with Outlook and smartphones.

When you add a client, a contact record is created for the individual or organization. Contact records
can be used by other clients and matters.

More Info: Details regarding client and contact functionality can be found in the Clients &
Contacts Guide and in Help.
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More Info: There are several short training videos that explain how the relationship between
clients and contacts work. You can access the videos at Tabs3.com/videos, or from the Help
menu in Tabs3 Billing or PracticeMaster by selecting Training Videos.

Secure Client Note: Contact information for secure clients (i.e. address/phone/e-mail) is stored
and edited in the Client file, rather than the Contact file. This is because contact records cannot be
marked as secure; contact information is viewable by all users with browse rights to the Contact
file. Likewise, address information for clients in matter mode is stored and edited in the Client file.

Selecting a Transition Date

You will want to choose a transition date when you start using Tabs3 Billing for the first time. The
transition date will serve as a point of reference for existing clients’ accounts receivable balances and
work-in-process balances being transferred to Tabs3 Billing from your previous method of time
accounting and billing.

When first starting to use Tabs3 Billing, if desired, you can enter the information for each client
excluding accounts receivable information. You can then come back later and enter accounts
receivable information, provided this is done before running final statements for the client. This
strategy has the advantage of allowing you some flexibility in determining the exact transition date
for accounts receivable.

Entering Accounts Receivable Balances

There are different methods that can be used to implement beginning accounts receivable balances.

e Method 1 - Entering Balances via the Client File
Accounts receivable figures can be entered in the Client File. Balances are entered on the A/R
& Fund Balances tab.

e Method 2: - Entering Transactions and Running Final Statements
Accounts receivable figures can be generated by entering fee and cost transactions for the
accounts receivable balances, and then running final statements with the transactions and
updating those statements.

e Method 3: - Custom Conversion
A custom conversion can be performed. Contact your local reseller or Software Technology,
Inc. for more information.

Aging of accounts receivable is based on the date of each statement.

The following table includes the pros and cons of each method.
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Method Pros Cons
Method 1: e Fast e No aging for balances consisting of
Entering Balances via | ¢ Can break out fees, multiple statements
the Client File expenses, advances, e No breakdown by Working Timekeeper or
sales tax, and finance Cost Type
charge e Receipts will be allocated to a single

designated R/A Timekeeper, Expense Cost
Type 0, and Advance Cost Type 0

Method 2: e Can break out fees, e Takes longer

Entering expenses, advances, e Calculated finance charges may not
Transactions and sales tax, and finance match original finance charge amount
Running Final charge e Sales tax may be calculated differently
Statements e Optionally include than originally billed

breakdown by working
timekeeper and/or cost
type

e Optionally run separate
statements for aging

purposes
e Provides greatest details
Method 3: e Customized to your e Additional charges
Custom Conversion specifications e Additional time required

Customized to your
specifications

Method 1: Entering Balances via the Client File

Accounts receivable information can be entered on the A/R & Fund Balances tab of the client
program. When entering initial accounts receivable balances using the Client file, you can use one of
the following methods:

e Enter one total amount due in the Fees Due, Expenses Due or Advances Due field; or
e Enter separate amounts in the Fees Due, Expenses Due and Advances Due fields.

Additionally, amounts can be entered for Finance Charge Due, Fee Sales Tax Due, Expense Sales Tax
Due and Advance Sales Tax Due. The Last Statement Date can be specified for aging purposes and
assessing future finance charges on past due balances. All of the remaining fields (dates and
payment information) are optional and are only printed on reports to provide statistics about the
client.

Note: When using this method, a client’s accounts receivable balance must be entered before a
final statement is run for the client.

-26 -



Tabs3 Software Administrator Guide

When a new client is added with balance due information on the A/R and Fund Balances tab, a
client ledger record is automatically created for that client. Likewise, whenever an existing client who
has never been billed is changed from a zero balance due to a non-zero balance due, a client ledger
record is automatically created for that client.

This client ledger record is a statement record and includes all of the amounts entered on the A/R &
Fund Balances tab.

e Any fees due entered are attributed to the specified R/A Timekeeper on that tab (if no R/A
Timekeeper is specified, then the primary timekeeper is used instead).

e Any expenses due are attributed to expense cost type 0.
Any advances due are attributed to advance cost type 0.
The Last Statement Date on the A/R & Fund Balances tab is used as the date of this client
ledger record. If a Last Statement Date is not entered, the Date Opened from the Address
tab of client information is used.

Once a client ledger record has been created for the client (either by adding an accounts receivable
balance or by updating a statement), the accounts receivable fields on the A/R & Fund Balances tab
of client information become read-only and cannot be edited.

If you want to break down the accounts receivable by working timekeeper and cost types, instead of
using this method, you will need to enter separate transactions for each timekeeper and cost type
using the Fee Entry and Cost Entry program (i.e., Method 2).

If you want to break down the balance that clients owe you into separate statement amounts for
aging purposes, instead of using this method, you can do this by final billing and updating
transactions on separate statements with corresponding statement dates (i.e., Method 2). However,
this is a time consuming task.

In summary, the advantage of entering accounts receivable balances via the Client file is that it is
quick. Disadvantages include: 1) Only one aging period is used for the aggregate past due balance;
and 2) The fee amount due is automatically applied to the R/A Timekeeper for the client (specified
on the A/R & Fund Balances tab of the Client file), the expense amount due is automatically applied
to Expense Type 0, and the advance amount due is automatically applied to Advance Type 0.
Therefore, when payments are allocated, they will automatically be allocated to the R/A Timekeeper,
Expense Type 0 and/or Advance Type 0.

Method 2: Entering Transactions & Running Final
Statements

As an alternative to entering balance due information on the A/R & Fund Balances tab of the Client
file, you can enter fee, expense, and advance transactions for past due information, run a final
statement with those transactions, and update the final statements. If you want to use this
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information and retain accurate aging information and billing history, you would have to repeat it
for each past due statement for each client. This method has the disadvantage of taking
considerably longer to accomplish. However, it has the advantages of maintaining accurate previous
historical information.

If you want to maintain billed and due information for each timekeeper and/or cost type, you must

use this method.

Sales Tax Note: If you want sales tax tracked separately, you can configure Tabs3 Billing for sales
tax and enter the fee and transactions with amounts that exclude the sales tax. Alternatively, you
can include sales tax in the transactions that you enter; however, receipts will not be allocated to

sales tax.

Finance Charge Note: Because finance charge is always calculated, we recommend using the
following method for entering beginning finance charge balances. Set up a separate finance
charge transaction code using an Expense or Advance Cost Type. Enter a separate transaction for
the cumulative finance charge amount (or a separate transaction for finance charge for each
statement). This method will let you track payment allocations for finance charge under the
designated cost type. (Note: When using this method, do not enable finance charge until after you
have completed entering the initial balances. Be aware that once finance charge is enabled,
finance charge will be assessed on the past due expense/advance balances. Reports will show
payments as allocating towards the designated expense or advance cost type.)

Method 3: Custom Conversion

Firms who are converting from other software systems may want to investigate the possibility of
having a custom conversion performed. Client information, accounts receivable, and statement
history may be able to be converted, depending on which software you are converting from. Contact
your local reseller or Software Technology, Inc., for more information.

Examples for Entering A/R Balances

The following illustrates variations on how you might enter initial accounts receivable balances for a
client using Method 1 and Method 2.

For example, let's say a client has the following balance due as of the selected transition date.

Statement Statement Fees Expenses
Date Amount Due Due
March 31 $500 $400 $100
April 30 $300 $250 $50
Total $650 $150
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e Method 1 Options - Enter Balances via the Client File
e If you want the amounts due broken down for fees and expenses, you would enter
$650 in Fees Billed, $150 in Expenses Billed and April 30 for the Last Statement Date.
If desired, you could specify a single R/A Timekeeper for receipt allocation purposes.

e If you want a simple lump sum for the total amount, you would instead enter $800 in
Fees Billed and a Last Statement Date of April 30.

e Method 2 Options - Entering Transactions and Running Final Statements
e If you want amounts due broken down by aging period, you would enter four
transactions:
o a fee transaction dated March 31 for $400,
e afee transaction dated April 30 for $250,
e an expense transaction dated March 31 for $100; and
e an expense transaction dated April 30 for $50.

e Once all transactions are entered for all statements for all clients, you would run
batches of final statements and update the final statements using a process similar to
the following. It is important to note that the Update Statements program must be
run in between each final statement.

e Run a final statement dated March 31 using a March 31 cut-off date.
e Run the Update Statements program for the March 31 statement.

e Run a final statement dated April 30 using an April 30 cut-off date.

e Run the Update Statements program for the April 30 statement.

e If you want amounts due broken down by timekeeper, you would use a process
similar to the one above, but instead of a single fee transaction for each statement,
you would enter separate fee transactions for each working timekeeper for each
statement.

Entering Work-in-Process Balances

If any of your clients have work-in-process as of your transition date, you will need to enter this
information using the Fee Entry, Cost Entry and Payment Entry programs.

Tip: Use a date for the work-in-process entries that is prior to your transition date. For example, if
you have selected a transition date of April 1, enter the work-in-process transactions using the
date that the transaction actually took place or a date of March 31 (as opposed to an April date).
This will allow for accurate April figures in the Worked section of the Timekeeper and Category
Productivity Reports.

There are three methods of transferring the fees from your previous billing system:

e Make multiple fee entries for each client. This method gives you the most detail for client
statements and the most accuracy for productivity reports. It also takes the most time to
transfer work-in-process from your previous system; or
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e Make one fee entry for each timekeeper for each client that has work-in-process; or

e Set up a timekeeper called “WIP CARRY-OVER". Make one fee entry for each client that has
work-in-process. This method has the advantage of being the quickest method of
transferring work-in-process balances. However, the disadvantages include the inability to
allocate payments and productivity to working timekeepers.

In addition to entering fee work-in-process, you must also enter any expenses and advances that
have not been billed. You can do this one of two ways:

e Make individual expense and advance entries for each client. This method gives you the
most detail for client statements. It also takes the most time to transfer work-in-process
information from your previous system; or

e Set up two transaction codes called “WIP CARRY-OVER,"” one for expenses and one for
advances. Make one cost entry for each client for each transaction code for the total amount
of expenses/advances unbilled at the time of starting Tabs3. This method has the advantage
of being the quickest method of transferring work-in-process balances. However, one
disadvantage is the inability to allocate payments and productivity to cost types.

Billing Rates
Tabs3 Billing is extremely flexible when it comes to defining billing rates. The two most common
methods of defining rates are the timekeeper rate and the client rate table.

e You already defined timekeeper billing rates when you set up the timekeeper file (page 20).

e You can define unique billing rates by client for each timekeeper if desired. These rates are
defined in a client rate table, which is accessed in the Tabs3 client file via the Rates tab.

A complete discussion of the different billing methods and ways to set hourly rates can be found in
the Billing Methods Guide.
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Fee Compensation Rules

Tabs3 Billing provides the ability to define Fee Compensation Rules that can be used to designate
exactly how you want fee receipts allocated. These rules provide the ability to define multiple
originating timekeepers, threshold amounts and effective date ranges.

Fee compensation rules are defined for clients via a fee compensation rules table. Fee compensation
rules provide the ability to specify a percentage of a client's fee receipts that you want allocated to a
specific primary, secondary, or originating timekeeper or to the firm. Each table can include multiple
rules. You have the ability to create rules for multiple originating, primary, and secondary
timekeepers as well as multiple rules for the same timekeeper. Rules can be based on a percentage of
receipts from:

e all working timekeepers

selected working timekeepers

all working timekeepers assigned to a specific timekeeper level
statements within a specified date range

accumulated receipts within an amount range.

For example, your firm may want to allocate 10% of all fees received to the originating timekeeper.
Or you may want the primary timekeeper to receive 3% of all fees received and the firm to receive
1.85% of all fees received. Perhaps you want 25% of all fees received up to the first $1,000 allocated
to a specific timekeeper and 2% of all fees received through December 31 allocated to the primary
timekeeper. You may want to allocate a specific percentage of all fees received for paralegal billings
to the originating timekeeper. The combinations are endless.

You can define custom rules tables for each client. Or, you can define a table and share it with other
matters.

» To define a fee compensation rules table

1. From the Tabs3 Billing File menu, point to Open and select Client.
2. Click the Setup tab.

3. Under Payment Settings, click the Fee Compensation Rules button.
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E Client Information EI
Biling Options | Billing Freferences I Statement Options I Split Billing I Budget
Address | Setup | Rates I A/R & Fund Balances | Client Notes I Custom Fields
Client ID: 850,00 White/Kelly
Divorce
Settings

Biling Category: 35 - Family Law

Biling Frequency: Morthhy - Monthly Clients

Report Order Timekeepers Status

Primary: 5 - Kendra |. Michaels [C] Task Based Biling Client
Non-billabl

Secondary: 1 - Michael L. Jensen [ Non-bilable

Originating: 4 - Robert 0. Bums

Payment Settings

Method to Apphy Payments: [Z-Nl {Oldest FinCha, Oldest Advs, Oldest Exps). All Fees -

Receipt Allocation by Invoice

's Defined

Figure 26, Fee Compensation Rules button

Fee Compensation Rules Tabl

i
Client 1D 850.00 el

Divorce
Source -Camcel
(@) Custom () Shared () Use Existing T able
Table to se: -
++

Tmkr Mame Type Receipt % Taken From BeginDate EndDate  From Amount ToAmount -

10.00[ALL - All Timekeepers | mm/dd/pwyy | mm/ 0.00 3
4 Robert 0. Buns Oiiginating 35.00 ALL - All Timekeepers mm/dd Ay mmedd Ay 0.0 5,000.00
5 Fendra . Michaels Originating 15.00 Selected mm/dd Ay mmAdd Ay 0.00
5 Kendra . Michaels Primary 25.00 Selected m/dd Ay mmAdd Ay 000

[ Mew | [ Edt | [Dekte | [Ckaar]

Figure 27, Fee Compensation Rules Table

Tip: If no fee compensation rules are defined, fees will be allocated based on working timekeeper.
If you want to define fee compensation rules, define them before entering payments.

More Info: Complete details regarding fee compensation rules can be found in Help.
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Methods of Billing

Tabs3 Billing provides the ability to implement the following different billing methods:

Hourly Billing
Contingency Billing
Flat Fee Billing
Value Billing
Progress Billing
Retainer Billing
Split Fee Billing
Task Based Billing
Threshold Billing

More Info: Complete details regarding each of these billing methods can be found in the Billing
Methods Guide and in Help.

Statements

Tabs3 Billing lets you customize statements to print the way you want them to look. You can mail or
e-mail statements as PDF files to your clients. Generate all of the e-mails and PDFs at once and
automatically insert variables such as the last payment date, outstanding balance, and other client
information into the e-mail. You can generate statements for any client or group of clients. Use the
Pre-Bill Tracking feature to print draft statements and track which ones are still under internal review.

More Info: The Statements Guide discusses the billing process, how to run statements, how to
use Pre-Bill Tracking, and other statement related utility programs in Tabs3 Billing.

More Info: The Statement Formatting Guide includes detailed information on how to format
statements to meet your firm's needs.

Setting Up the Statement Printer

Tabs3 Billing has additional printer configuration options for statement printers.

> To define the statement printer options

1
2
3.
4

From the File menu select Print Setup.
The Printer Setup window will open.
In the Printer field, select the desired statement printer.

Click the Statement Setup button to configure the different statement printing options.
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Mormal Font: 10 pt Arial [ Print Ervelopes

Statement Width

. Enable Statement Designer Layouts
Automatic; 100 Percent Adjustment @ g ¥

() Fined: u] Colurnns

Page One

Heading Font: 10 pt Avial -

Faper: [Letter - Source: [Auto Select -

Elank Lines at Page Top: 0 Blank Lines Befare Detal: 2 [7] Compress Address
[ Bitmap Select... [nane]

Bitmap ertical Placement:  |0.000 Bitrnap Aligrment: | Flush Left Mangin

Continuation Page

Paper: Letter Saurce: Auta Select

Blank Lines Before Detail:

Envelopes

Faper: Lether Source; Auta Select
Address Print Positior: Herizortal: | 0.000 Wertical: 0.00a

FPaper Oriertation: (@) Portrait Landzcape

[ 0K ] [ Cancel ] [ Help

Figure 28, Statement Setup

More Info: Complete details regarding print options can be found in Help.
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Setting Up PracticeMaster

Until you are ready to start using individual features in PracticeMaster, there are just a few settings
that you will want to implement. Additional detailed information regarding how to customize
PracticeMaster for your firm can be found in the Customizing PracticeMaster Guide.

Customization

The first time you start PracticeMaster after installing the software, the Customization window will be
opened. The Customization window consists of two tabs - the Main tab and the Documents tab.
You need to define your Key Type and Decimal Places. If you are using Billing, you need to make
sure the Key Type and Decimal Places match those defined in Tabs3 Billing Customization. Details
regarding these fields can be found on page 17 of this guide and in Help.

You can leave the History Tracking options at the default. The options on the Documents tab can be
configured when you are ready to use Document Management. Detailed information can be found
in the Document Management Guide.

Customization Customization

i D t:
Manage Documents
Key Setup () Manually specify document folder and file names £
Key Type: MNumeric 12345 @ Automatically assign document folder and file names
Document Store: Assembled "
Decimal Places: £ Mote: Relative or UNC paths are recommended (\'server\share) 4
Folder Naming Doe_Jonr\123145\, 1
History Tracking
Fils N 2 _Conf 20140224-Medical Record st pdf
Enable History Tracking e Haming m ical Records Request.p
Limit history file size: Checkout Options r
[~ Require users to check out managed documents before editing
Always create a new version when checking in managed documents
. Checked out documents are considered overdue after 14 |5 days
[ Show overdue documert list for users when logging in
e . oy 3
Figure 29, PracticeMaster Customization - Main tab Figure 30, PracticeMaster Customization -

Documents tab

Worldox Note: In order to avoid conflicts, users who manage their documents using World
Software Corporation's Worldox® programs should not configure PracticeMaster to
Automatically assign document folder and file names.
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Using PracticeMaster without Tabs3 Billing

When using Tabs3 Billing, many settings and data files that are set up in Tabs3 Billing are mirrored
over to PracticeMaster. However, if you are using PracticeMaster without Tabs3 Billing, you will need
to set up the information shown in the following table. This table includes page number references
with details on how to set up the files.

Completed Data Information
Key Type Page 12
Timekeeper Level Page 19
Timekeepers Page 20
Categories Page 21
Tcodes Page 21
Cost Type Page 24
Task Code Sets Page 24
Task Codes Page 24
Location Page 24

Clients and Contacts

Client and contacts entered in Tabs3 Billing are automatically saved in PracticeMaster.

More Info: Details regarding client and contact functionality can be found in the Clients and
Contacts Guide and in Help.

More Info: There are several short training videos that explain how the relationship between
clients and contacts work. You can access the videos at Tabs3.com/videos, or from the Help
menu in Tabs3 Billing or PracticeMaster by selecting Training Videos.

Secure Client Note: Contact information for secure clients (i.e. address/phone/e-mail) is stored
and edited in the Client file, rather than the Contact file. This is because contact records cannot be
marked as secure; contact information is viewable by all users with browse rights to the Contact
file. Likewise, address information for clients in matter mode is stored and edited in the Client file.

Contact Categories
PracticeMaster allows you to create categories for your contacts, thus making it easy to view
contacts by category. By default, PracticeMaster includes the following contact categories:

e Attorney
e C(Client
e C(lient Contact
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e Court
e Court Reporter
e Judge

You can add contact categories as desired to fit your firm's needs. Examples of other categories
include Expert Witness, Investigator, Insurance Adjuster, Doctor, Hospital, Medical Provider,
Personal, etc. Up to 20 contact categories can be assigned to each contact. Contact categories are
optional. Although you can add contact categories at any time, you may want to add the contact
categories now for those categories that you know your firm will use.

» To add a Contact Category

1. From the PracticeMaster menu, click File | Open | Contacts.
2. Click the Contact tab right of the List tab.

3. Find the Contact Category field and click the ¥ button on the right side to open the
Contact Categories window.

Click New.

Enter the desired Contact Category.

Click OK to save the new Contact Category.

owv s

Contact categories can be used to filter which contacts you want to synchronize to Outlook and
your smartphone.

Ej Contact Categeries [ El ﬁ]

v Category Mame -

Cliert

Client Contact
Court

Court Reporter
Judge

[ ok ] [ I ew ] [Eancel] [ Help ]

“ 4

Figure 31, Contact Categories window

Outlook Synchronization

If desired, you can synchronize your Outlook contacts into PracticeMaster, thus allowing you to
easily create clients from the contact records. Step by step procedures to do this can be found in the
PracticeMaster Quick Start Guide.
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Areas of Practice

Although you can start using Tabs3 and PracticeMaster out of the box, when you are ready to start
using PracticeMaster for managing your matters, you will want to take the time to customize the files
to meet your firm's needs.

You can set up separate Areas of Practice for the various types of law practiced. Each Area of
Practice has separate files for tracking unique information. For example, you might have a Family
Law area of practice, a Business Law area of practice and a Criminal Law area of Practice.

e The Family Law area of practice might have separate files for Assets, Debts, Spouse
Information, Income, Expenses, Children, etc.

e A Business Law area of practice might have separate files for Board of Directors,
shareholders, Financial Institutions, Signatories, etc.

e A Criminal Law area of practice might have files for Witnesses, Prior Convictions, Bonds, Plea
Bargains, etc.

One of the easiest ways to get started with creating your firm's areas of practice is to gather all
documents and intake forms related to that area of practice. Once gathered, highlight all of the areas
that are unique to the matter. Use this information to build or modify the files in your area of
practice.

More Info: Details regarding how to set up Areas of Practice can be found in the Customizing
PracticeMaster Guide and in Help.

Calendars

The PracticeMaster Calendar is one area that most firms begin using right away in PracticeMaster.
You will want to set up calendar codes, calendar groups, and calendar rights.

Calendar Codes
Just like Outlook, PracticeMaster categorizes calendar entries as Events (i.e., appointments) or Tasks.
You can also further categorize calendar records by calendar code.

PracticeMaster starter data includes default calendar codes. We recommend you review the current
calendar codes and add calendar codes that your firm requires.

» To view calendar codes

1. From the Setup Task Folder, click Calendar Codes.
2. The List tab includes a list of Calendar Codes.

- 38 -



Tabs3 Software Administrator Guide

> To print a list of calendar codes

1. From the Reports Task Folder, click Report Writer.
2. Highlight the Cal_Code report Name in the Report Writer window.
3. Click Print.

» To add a calendar code

1. From the Setup Task Folder, click Calendar Codes.

2. Click the L' button.
3. In the New Lookup Record window, specify a key value in the New Key field. The key value is

an up to 8-character label for the calendar code.
4. Click OK.
5. In the Calendar Code window, specify the settings for the Calendar Code.

6. Click the B button and close the Calendar Code window.

Groups
To use the calendar efficiently, you will want to make use of groups for calendaring and scheduling
purposes.

Smaller firms with just 1 or 2 users may not use groups. However, groups are particularly useful for
firms with multiple employees. For example, perhaps one particular attorney always works with one
particular paralegal and one particular secretary. You may want to set up a group with these 3 users
for ease in scheduling. Perhaps you may want a group for all attorneys, a group for all paralegals, a
group for all clerical employees. You will want to assign a person in the firm responsibility for
maintaining the various groups as new employees are hired.

» To print a list of groups

e From System Configuration, click the Reports menu, and select Group List.

» To add a group

e Refer to the steps on page 10 of this guide for how to add a group.
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Calendar Rights

If your firm is okay with all users seeing all calendar records on the PracticeMaster calendar, you do
not need to set up calendar rights. However, many firms want more control over who sees which
calendar records. Calendar records are considered public or private. Calendar records are public
unless the Private check box for the calendar record is selected.

. Phillips./Marcus
Cliert 1D 12101 T Real Estate Acquisition

Contact Wallace/Andrew C. = Andrew C. Wallace
User/Group DAN ~ |DAN

Keep Linked

Figure 32, Private check box in Calendar record

Calendar rights are defined at two different levels. First of all, you can define which users can view
the calendar. Users who have this right can view all public calendar entries for all users. This
particular right is defined in the access profile.

» To create an access profile

e Refer to the steps on page 4 of this guide for how to add an access profile.

» To verify the Calendar Display access right in an Access Profile

1. From System Configuration, click the File menu, point to Open, and then select Access
Profile.
2. The Access Profile window will be displayed.
a. Inthe groups of functions under the Access Name field, select Calendar.
b. In the list of Functions, the first item listed is Calendar Display.
c. Click Allow if you want to allow access to view the calendar. Otherwise clcik Disallow
if you do not want members of this access profile to have the rights to display the
calendar.

d. Click the button and close the Access Profile window.
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E Access Profile EI@

| System Activity | Tabs3| PM [GLs [ Tas [aps |

Access ID: PMDATA -

Access Name:  Limited Practice Master usage

»

File Information
a7 Foma, Designer

[an]

Reports
Search

Browse Plan Templates Yes £

Edt Plan Templates Mo

Process Plan Template Yes b

Browse Holidays Yes

Edt Holidavs bv Venue No i
Selected Functions All Functions Entire System

[ Allow ] [ Disallow ] [ Allow ] [ Disallow ] [ Allow ] [ Disallow ]

Figure 33, Calendar Display right in Access Profile

The second level of defining user rights is defined in the User ID record. Calendar rights can be
defined for each Logon user that is not a manager. Managers have all rights to all calendar records.
For each user, you can specify which users have rights to edit public calendar entries.

» To create a User ID

e Refer to the steps on page 7 of this guide for how to add an access profile.

» To edit Calendar Rights for a User ID

From System Configuration, click the File menu, point to Open, and then select Users.

Click the ™ button next to the User ID and select the user whose rights you want to define.
Click the Calendar Rights button
On the Rights to this Calendar tab:

a. Select the Allow all users to edit public calendar if it is okay for all users to edit
public calendar entries. Alternatively, if you want to pick and choose which users can
edit this user's public entries, clear the Allow all users to edit public calendar check
box.

b. Select which users you want to have Edit Public, Browse Private, and Edit Private
calendar rights.

5. Click the Rights to Other Calendars tab:
a. If you are a manager, you can select which users this user will have Edit Public,

Browse Private, and Edit Private rights for.

> wn o
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6. Click OK to close the Calendar Access Rights window.
7. Click E to save the changes made to the user.

Uzer Test Color

Setdview calendar access rights for this user: Calendar Rights 3

[ Disable Autofil for AT Tookup fields
[& llow CompuLaw Dates to be generated for this user in PracticeMaster

[ llow access via Tabs3 Connect Tabz3 Connect Settings

Figure 34, Calendar Rights button in User record

™ ™
Calendar Access Rights _ l&‘g Calendar Access Rights _ lélg
Rights to this Calendar | Rights to Other Calendars Rights to this Calendar | Rights to Other Calendars

The table below identfies which users have rights to view or change this user’s
calendar entries. By default, any user can view public calendar entries, but rights
must be explicitly given to view or edt private entries.

The table below identfies what other calendars this user has rights to view or change.
Additional ights must be granted by that user or a manager.

Allow all users to edit public calendar

Edit Browse Edit » Edit Browse Edit -
User 1D User Mame Fublic Private Private | Usger D User Mame FPublic Private Private |
Eeln gk I [ [ =

w Cathlzen Trudore

CHERYL Cheryl Bradley s CHERYL Cheryl Bradley

DanN Craniel H. Brady v DaN Craniel H. Brady

JASON Jazon|. Masterson v JASON Jazon |. Masterson

JEN Jennifer & Moonan ' JEN Jennifer &, Hoonan

JFP Jirmy P. Praum v JPP Jirary P. Praum

KENDRA Kendra |. Michaels [ KENDRA Kendra |. Michaels ' v

MLJ tdichael L. Jensen v ML tichael L. Jensen v

ROBERT Robert 0. Bumns ' ROBERT Robert 0. Burns

ROM Ronald P. Anderson v RON Ronald P. Anderson ' v v

Edit Public: [Bmwse PrivateJ [ Edit Private ]

[ Edit Public ] [Emwse F‘nvate] [ Edit Private ]

Figure 35, Calendar Access Rights Figure 36, Calendar Access Rights
Rights to this Calendar tab Rights to Other Calendars tab

Convert to Fee Settings

PracticeMaster makes it easy to convert various items into billable fee records. These fee records are
automatically mirrored over to Tabs3 Billing for billing purposes. You can convert calendar records,

document management records, and journal records to fees, including e-mail, notes, phone,
research, and timer records.

» To convert arecord to a Fee

e Right-click the record and select Convert to Fee.
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You can define the default settings that are used when users convert records to fees. Settings are
saved for each user and must be defined at the user's workstation.

» To define default Convert to Fee Settings
1. From the Maintenance menu in PracticeMaster, point to Preferences and select Convert to
Fee Settings.

2. Define the default settings for the record type as follows:
a. Click the corresponding tab for the desired record type (e.g., Calendar).

b. Define the settings for that record type.
c. Repeat steps a and b for each record type.
Click OK and close the window.

4. Repeat the above procedures for each user.

-
Convert to Fee Settings - DA

Calendar| E-mail |Note | Phone | Research | Timer | Document

Teode: 1 -

Phase/Task: B100  ~ Administration Activity:  A101 ~  Plan and prepare for
Default Timekeeper
@ Always use Timekesper 3 ~ Daniel H. Brady

() Timekeeper used for last fee

(7 Client's Primary Timekeeper

Default Description

@ Comments Field
(7 Teode/ Activity Code Description

(7 Customized Description

Converting One Record to One Fee
Timeto Bl 0.00 Hours

Combining Muttiple Records to One Fes
Time to Bil 0.00 Hours [ Apply to each e-mail before combining

‘When combining different types of joumal records, use the settings on the tab

Figure 37, Convert to Fee Settings window
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Document Management

When you are ready to start using Document Management, we recommend reading the Document
Management Guide.

More Info: Knowledge Base article R11572 includes the table of contents of the Document
Management Guide and links to other document management resources.



http://www.support.tabs3.com/main/R11572.htm
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Setting Up Tabs3 Financial Software

Tabs3 Financial Software consists of the following software:

e Tabs3 Trust Accounting Software (TAS)
e Tabs3 Accounts Payable Software (APS)
e Tabs3 General Ledger Software (GLS)

The following includes information on configuring these systems and how to transfer starting
balances.

More Info: Details on the data entry programs that are used on a daily basis can be found in the
Trust Accounting Guide, Accounts Payable Guide, and the General Ledger Guide. Additional
information regarding how the software integrates with other Tabs3 software can be found in the
Integration Guide.

Tabs3 Trust Accounting Software

Tabs3 Trust Accounting Software (TAS) is designed to help your firm keep track of the trust accounts
your firm manages.

TAS Customization

The first time you start Tabs3 Trust Accounting after installing the software, the Customization
window will be opened. The Customization window consists of two tabs. There are a few fields that
must be set before proceeding. Complete details regarding the fields on each tab can be found in
Help.

» Configuring the TAS Customization Window

1. Start Tabs3 Trust Accounting Software. The Customization window will be opened
automatically. (Note: If the Customization window does not open automatically, use the
Utilities | Customization menu to open the window.)

2. On the Main tab:
a. Specify the desired Key Type and Decimal Places. The values in these fields are used
to define the format of the trust account and client ID. These values must match
those specified in Tabs3 Customization and PracticeMaster Customization.

Note: Details regarding the Key Type and Decimal Places can be found on page 12.

3. Click MLC¥ to save the changes, then close Customization.
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Customization EI@ Customization EI@
Main | Merchart Services Main | Merchant Services
Key Type: Numeric  123.45 Decimal Places: |2 Trust Accounting has the ability to process credit card
depaosits at the time of entry. To sign up or lsan more

Default Bank Accourt #: [1] about Merchant Services. click the Leam More button

Check Printing Merchart Account Setup

©) Trust Account Order @) Entry Order Enable processing of Credit Card Deposits

Integration of Payments to Fim Print Merchant Account Setup Report ]

() None

(@) Integrate with Tabs3 (and GLS)
() Integrate with GLS {no Tabs3)

System Options
Allow deletion of verification lists without printing
[T Mlow editing of trust account curent balance
[T Allow editing of bank account current balance

Figure 38, TAS Customization - Main tab Figure 39, TAS Customization- Merchant Services tab

Startup Files

Before using Tabs3 Trust Accounting, you need to set up the following startup information:

e Attorney
e Bank Account
e Firm Payee

The following includes information on what information is stored in each of the startup files, as well
as step-by-step procedures for adding a record.

Attorney File

Attorneys are used in Trust Accounting to [ Miscellaneous ==
designate which attorney is responsible for the

Trust Account. Each attorney is assigned a
number, name, and initials.

Inactive

Michael L. Jensen

The attorney file in TAS is shared with the
timekeeper file in Tabs3 Billing. When
integrating with Tabs3 Billing, attorney
information must be added, changed, and
deleted using Tabs3 Billing. However, if you are
not integrating with Tabs3 Billing, you will need
to add attorneys in TAS.

ML)

Figure 40, TAS Attorney File
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» To add an Attorney

1. From the TAS Task Folders, click the Setup tab, and then click the Attorneys icon.

. . 1
2. By default, the Attorney tab is selected. Click L .
3. Specify the attorney number you want to use.

4. Enter the remaining information for the attorney.

5. Click E to save the new attorney.

Bank Account File

You will need to define a bank B Miscellancous
account where trust account Bank Account

funds are deposited. R

Last Check Number Used: 45340

Current Balance:
Tabs3 Statement WIP Terminology

Description:  First Bank IOLTA Account
[ Allaw Negative Trust Balance

10.227.02

Balance Texd: IYour tetainer balance is

Opening Balance Text: IDpen\ng retainer balance

Closing Balance Text: ICloSing retainer balance

Bill Remittance Text: IAS per our agreement pleaze remit:

Target Remittance Text: ITo meet

Reg: 500 - Payment

Exp -

GLS Debit Account:

GLS Journal Mumber:
GLS Credit Accourts for Payments
Reg:
Exp:

Tabs3 Transaction Codes for Payments

your minimum retainer balance, please remit:

Fee: -
Adv: -
Fee:
Adv:

- GLS Accrual Information

Figure 41, TAS Bank Account
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» To add a Bank Account

1. From the TAS Task Folders, click the Setup tab, and then click the Bank Accounts icon.

2. In the Bank Account field, select 1.

a. Enter a Description for the bank account.

b. Specify the Last Check Number Used for this bank account. TAS will increment this
field by 1 when you enter a check that has already been printed or TAS prints the next
check.

c. Ifintegrating with Tabs3 Billing, under the Tabs3 Transaction Codes for Payments
section, specify the Tabs3 Billing payment transaction code you want used when
funds are transferred to a client's account.

3. Click to save the new bank account.

4. Add any other bank accounts as needed.

Once your bank accounts have been defined, you can add trust accounts and specify which bank
account to use for depositing the trust funds.

Firm Payee

When integrating with Tabs3 Billing, you must Miscellaneous =n(E=H|
set up a payee named "FIRM". This payee will be | [omey | Paye= | Bank Accourt

used for any funds that are paid from a trust
account to your firm.

Payee Mame FIRM Ad

Payee Address Line 1: 1621 Cushman Drive
Payee Address Line 2. Lincoln, NE 68512
Payee Address Line 3:

Federal ID #: 12-3456789

1099 Info: Box 7 -

Figure 42, TAS - Payee of FIRM

» To add the Firm Payee

1. From the TAS Task Folders, click the Setup tab, and then click the Payees icon.

2. In the Payee field, enter FIRM.
a. Verify your firm's address. TAS will automatically retrieve the firm address that was
entered in the Firm Information program in System Configuration for the Payee
Address Lines.
b. Verify your firm's Federal ID #. TAS will automatically retrieve the firm address that
was entered in the Firm Information program in System Configuration.
c. Inthe 1099 Info field, specify the box number you want used for the 1099 form
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generated to your firm as a payee.

d. Click E.Ito save the payee.

When entering checks or EFTs (electronic funds transfers), you can enter FIRM in the Payee field.
When FIRM is used, Tabs3 General Ledger journal entries and Tabs3 Billing payment transactions will
be posted at the time the check or EFT is entered. However, if the check number is "0", then the

GLS journal entries and Tabs3 Billing payment transactions will be created and posted when the
check is printed.

Trust Accounts and Trust Transactions
Typical daily use of Trust Accounting Software generally consists of adding trust accounts and trust
transactions.

Trust A unique Trust ID is assigned to each individual trust account. Trust IDs use the same

Accounts client ID as Tabs3 Billing clients and matters. Each trust account is assigned a bank
account number.

Trust Trust transactions consist of checks, deposits, and EFTs (electronic funds transfers).

Transactions | When first starting to use Trust Accounting Software, you will need to enter the
starting balances for each of your trust accounts as discussed in the following "Trust
Account Balances" section. Before you can enter balances, you will need to set up
your trust accounts.

More Info: Detailed information on the Trust Account and Trust Transactions programs can be
found in the Trust Accounting Guide and in Help.

Trust Account Balances

Trust Accounting Software stores a balance for each trust account and a balance for each bank
account. These balances are automatically updated whenever a deposit, check or EFT transaction is
entered.

When first starting to use Tabs3 Trust Accounting, trust account balances can be transferred by
entering an initial deposit. Use the Trust Accounts program to set up a trust account. Then, use the
Trust Transactions program to enter a deposit for the beginning balance. This deposit can represent
the original deposit used to open the trust account, or it can represent the trust account’s current
balance.
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Initial Deposit Method | Description

Original Deposit If you elect to enter the amount of the original deposit used to open the
trust account, you must also enter trust transactions for all subsequent
activity. This method gives you the most detail but also requires the
most time for data entry.

Current Balance If you elect to enter the current balance as the initial deposit instead of
all history, you can enter the historical activity at a later time. If and
when you decide to enter the historical activity, either delete the
deposit transaction used to post the initial balance or enter a negative
deposit for the same amount.

Bank Account Reconciliation Note: Keep in mind the Bank Account Reconciliation program when
deciding how much history to enter. For example, let's say it is May 15 and you are just starting to
use Trust Accounting Software. You've decided you do not want to enter all of the historical
activity for all trust accounts at this time. However, you would like to start using the Bank Account
Reconciliation program for the month of May. The bank account has been reconciled with the
April bank statement. Therefore, instead of entering a deposit for the trust account's May 15
balance, enter a deposit for the April 30th balance (i.e., the closing balance from the April 30th
bank statement). Then, enter trust transactions for all transactions that haven't cleared as of the
April 30th balance.

Note: The Current Balance field in the bank account file and the Current Trust Balance field in
the trust account file are typically not edited. Although a balance can be entered in the trust
account’s Current Trust Balance field, we do not recommend using this method because it
requires that corresponding changes be manually made to the bank account’s Current Balance
field. Furthermore, no audit trail will be shown for the beginning balance. Balances can only be
edited if the corrresponding option has been enabled in TAS Customization.

Check Forms
Tabs3 Trust Accounting checks can be printed on check forms from Nelco. Laser check forms or
continuous form checks can be ordered from Nelco via their Web site at:

NelcoSolutions.com/Tabs3

A brochure and order form for checks is included with the software.

More Info: Additional information and frequently asked questions regarding Nelco check forms
can be found in Knowledge Base Article R10978, "Ordering Tabs3 APS & TAS Checks and Forms
from Nelco" (support.Tabs3.com).
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Configuring Check Printers

Checks are configured at the printer level via the Check Setup button in the Print Setup window.

» To define the default TAS check printer

1. From the File menu in TAS, select Print Setup.

2. The Printer Setup window will open.
a. Inthe Printer field, select the desired default printer.

b. Click Check Setup.

1. Select the desired options for the check printer setup.

2. Click OK.
3. Click OK to save the printer.

More Info: Additional information regarding printers can be found on page 33 of this guide.
Detailed information regarding each option can be found in Help.

,

" e ™
TAS Check Printer Setup for Brother HL-2270DW on 192.168.200.57_1 —g-

Frinter: [Brnther HL-2270DW series

- Setu
]

[ Page Setup ] [ Check Setup ] [AdvancedF’rmtlngFeatures]

Font Selection Mode
@ Automatic () Manual
Automatic Font Selection Setup

Base Font: il

tanual Font Selection Setup
0-40 Columns 10 pt Arial
41 - 80 Coluranz 10 pt Arial
81-132 Columns 10 pt Adial
133 - 160 Columns 10 pt Arial
161 - 285 Columnz 10 pt Anial

[ oK ][ Cancel ] [ Help

]

Figure 43, TAS Printer Setup

Select
Select
Select
Select

Salect

Spell Dut Check Amaunt Print Mema on Checks

Check Mumbers Prepiinted on Check [ ] Print Trust Account Mame on Checks
[ Print Check Number

Print Duplicate Stub

Pririt Trust ID on Check Stub

Paper. Letter -
Saurce
[ (n]:4 ] [ Cancel ] [ Help ]

Figure 44, TAS Check Setup
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Tabs3 Accounts Payable Software

Tabs3 Accounts Payable Software (APS) makes bill paying easier. Invoices and manual checks
entered in APS can easily be charged to Tabs3 Billing clients and you can specify which General

Ledger accounts to post to.

APS Customization

The first time you start Tabs3 Accounts
Payable after installing the software, the
Customization window will be opened.
The Customization window consists of
three tabs. There are a few fields that
must be set before proceeding.
Complete details regarding the fields on
each tab can be found in Help.

i:: Customization

Main | Tabs3 I General Ledger

Key Length

Decimal Places: |0

Defautt Bark: [ [] Check for Duplicate Invoices

Allow deletion of verfication lists without printing

[T Prirt miscellaneous vender address on Pre-Check Register
Print miscellaneous wendor address on Cash Requirements Report

Print miscellaneous vendor address on Check Register

Aging Periods
Period 1: 28 Period 2: 14 Period 3: 7
Period 4: ] Period 5: -7

Figure 45, APS Customization window

» Configuring the APS Customization Window

1. Start Tabs3 Accounts Payable Software. The Customization window will be opened
automatically. (Note: If the Customization window does not open automatically, use the
Utilities | Customization menu to open the window.)

2. On the Main tab:

a. Specify the desired number of Decimal Places you want used for the vendor
numbering format. If you do not want to use Decimal Places in your Vendor ID, leave

the value at 0.

Note: Details regarding the Decimal Places can be found in the Help.

b. Change the Default Bank to 1. We will define the bank account after saving

Customization.

3. If you are integrating with Tabs3 Billing, click the Tabs3 tab, select the Integrate with Tabs3

option and any other desired options.
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4. If you are integrating with General Ledger, click the General Ledger tab, select the Integrate
with GLS option and any other desired options.

. = L
5. Click to save the changes, then close Customization.

Bank Account Information

Before using Tabs3 Accounts Payable, Bank Account =8 ==
you need to set up your bank account. " Banic Acoourt | Recuring Enly |
Bank Account # 1 =
Description:
Last Check #: 25657

GLS Accounts
Cash Account #: 1110.00 + Operating Accourt

Accounts Payable Account #: -

Check Layout

() Nelco Check Layout L1445
Automatically switch to Nelco Check Layout L1572
Last check # using Melco Check Lavout L1445;
First check # using Melco Check Layout L1572:

@ Nelco Check Layout L1572

Figure 46, APS Bank Account

» To add a Bank Account

1. From the APS Task Folders, click the Setup tab, and then click the Bank Accounts icon.
2. In the Bank Account # field, select 1.
a. Enter a Description for the bank account.
b. Specify the Last Check # used for this bank account. APS will increment this field by
1 when you enter a manual check or when APS prints the next check.
c. Ifintegrating with GLS, specify the Cash Account # for the bank account. Optionally
specify the Accounts Payable Account #.
d. Specify which Nelco check layout will be used.

[
3. Click to save the new bank account.
4. Add any other bank accounts as needed.

Once your bank accounts have been defined, you can add vendors and invoices.

More Info: Detailed information on the Vendor and Invoices programs can be found in the
Accounts Payable Guide and in Help.
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Check Forms
Tabs3 Accounts Payable checks can be printed on check forms from Nelco. Laser check forms or
continuous form checks can be ordered from Nelco via their Web site at:

NelcoSolutions.com/Tabs3

A brochure and order form for checks is included with the software.

More Info: Additional information and frequently asked questions regarding Nelco check forms
can be found in Knowledge Base Article R10978, "Ordering Tabs3 APS & TAS Checks and Forms
from Nelco" (support.Tabs3.com).

Configuring Check Printers

Checks are configured at the printer level via the Check Setup button in the Print Setup window.

» To define the default APS check printer

1. From the File menu in APS, select Print Setup.

2. The Printer Setup window will open.
a. In the Printer field, select the desired default printer.
b. Click Check Setup.
1. Select the desired options for the check printer setup.
2. Click OK.

3. Click OK to save the printer.

™ N
Printer Setup ‘ ﬁ APS Check Printer Setup for Brother HL-2270DW series on 192.168,200.57 [
o E Seh
Piinter. | Brother HL-22701Diw series - [ Setp | Spell Out Check Amount Fiint Memo on Checks
. [Dnly for Check Layout L1572)
- Il
[ Page Setup ] [ Check Setup ] [ Advanced Printing Features ] Uik miies Fepted enCiee
[ Print Check Number
Font Selection Mode [ Print Duplicate Stub

@ Automatic ) Manual [ Print Vendar # on Check Stub

Automatic Fant Selection Setup

Baze Font: Aial Faper
Souce
M anual Font Selection Setup
0-40 Columns 10 pt Al T [ ok ][ comel | [ hHep |
41 - 80 Colurn: - 10 pt Arial Select
#1132 Columns 10 pt Ara — Figure 48, APS Check Printer Setup
133- 160 Colurnns 10 pt Aial el More Info: Additional information regarding
161- 285 Columns 10 pt Avial Select printers can be found on page 33 of this guide.
o] [Ccames ] [ e ] Detailed information regarding each option

can be found in Help.

Figure 47, APS Printer Setup
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Tabs3 General Ledger Software

Tabs3 General Ledger Software (GLS) is a comprehensive general ledger system for any type of
business and is based on a double-entry accounting system.

Cash Basis Accounting vs. Accrual Accounting

The majority of GLS users are on a cash basis of accounting. However, many users are on a modified
accrual basis of accounting or an accrual basis of accounting. Our accounting software can be
successfully used by any firm—no matter which type of accounting method you use. Accrual
posting features are available as described in the following.

Accrual Posting of Tabs3 Accounts Receivable Figures

Accrual Posting of Tabs3 Work-in-Process Figures

Accrual Posting of Tabs3 Client Funds Balances
The Tabs3 Billing Software can be configured so that GLS journal entries can be
posted based on balances from Tabs3 accounts receivable, work-in-process and
client funds. Journal entries can be firm wide or by primary timekeeper and can be
broken down by fees, expenses, advances, and finance charge. The software can be
configured so GLS financial statements can be run with or without accrual account
balances.

Accrual Posting of TAS Bank Account Balances
The Trust Accounting Software (TAS) can be configured so that GLS journal entries
can be posted based on TAS bank account balances. The software can be
configured so GLS financial statements can be run with or without the TAS bank
account balances.

Accrual Posting of APS Accounts Payable Figures

The Accounts Payable Software (APS) includes a feature that allows you to post GLS
journal entries on a cash basis of accounting or an accrual basis of accounting. You
have the option of posting GLS journal entries from APS after checks have been
printed and posted or before the checks have been printed. If you post GLS journal
entries on a cash basis of accounting, an optional feature is included that allows
you to post unpaid invoices, run GLS financial statements, and then unpost unpaid
invoices. This feature gives you the advantage of being on a cash basis of
accounting but still having the ability to print financial statements that include your
accounts payable figures.

More Info: Details can be found in Help in the Post Tabs3/TAS Accrual Balances program.
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General Ledger Clients

In GLS, a client is a business entity for
which books are kept. GLS allows up to
999 sets of data to be configured, which
enables the firm to keep separate books
for multiple entities on the same
computer. If you are keeping financial
information for only one entity, then
only one GLS client needs to be set up.

Note: Integration with Tabs3 Billing,
Accounts Payable, and Trust
Accounting can only occur with
GLS Client 1.

» Adding GLS Client 1

\_- Edit GLS Client

(o] 5 |

Client Murmber: -

Cligtit M anne: Jenzen, Martin & Anderson

Configuration

D ata Location:  Curenf Working Oirecfony

Account # Decimal Places: 2

Beginning Fizcal Month: Janua v

Jaumnal Entry D ate Restrictions
V| Riestrict Jounal Entries to - 30 *  daps in the future

Restrict Journal Entries to |60 daysz in the past

D ate through which books are clozed: 12/31/20010 =
Options

| Allows deletion of verification lists without printing

Allow an alternate account order to be defined in the Chart of Accounts

Figure 49, Edit GLS Client window

1. Start Tabs3 General Ledger Software. The GLS Client window will be opened automatically.
(Note: If the GLS Client window does not open automatically, use the Utilities | Edit
GLS Client menu to open the window.)

2. Enter 1in the Client Number field.

Enter the firm's name in the Client Name field.

In the Account # Decimal Places, specify the number of decimal places you want

a.
b. Leave the Data Location field blank.
c.
used for your account numbers.
Specify your Beginning Fiscal Month.
e. Change any other options as desired.

3. Click ET.I to save the GLS Client.
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Journal Names

Journal entries are recorded in a specific journal.
You can use one or more journals to classify
journal entries. At least one journal must be
defined. Firms who use one journal typically
define that journal name as the General journal
and then use the Reference field in the journal
entry for classifying their journal entries.
Examples of journals include Cash Receipts,
Cash Disbursements, Miscellaneous.

» To define a journal

1
2. Enter the Journal #.
3. Enter the Journal Name.
. :
4. Click ¥ to save the journal.
Departments

Departments are used to classify divisions within
a business organization. You can use
departments to refer to profit centers or
locations. The use of departments is optional
and allows financial statements to be printed for
individual and combined divisions. One of the
most common uses of departments in GLS is to
create separate departments for each partnerin
the firm so that financial statements can be
printed for each individual partner.

» To define a department

Enter the Department #.
Enter the Description.

=]
Click to save the department.

> wnN e

-
0 nr
Miscellaneous

Joumal # 1 -

Name: General

iy

Figure 50, GLS Journal Name

From the GLS Task Folders, click the Setup tab and then click the Journal Name icon.

T
Miscellaneous

Joumal | Department

Description:

Department #: -

Figure 51, GLS Department Name

From the GLS Task Folders, click the Setup tab and then click the Department icon.
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Chart of Accounts

The Chart of Accounts is the "heart” of the GLS system. Because every firm's chart of accounts is
unique, GLS provides the ability to create your own customized chart of accounts. You can use the
chart of accounts that comes with the software, modify it to fit your current account structure, or
build your own chart of accounts from scratch. To save time, we recommend using the chart of
accounts that comes with the software and modifying it as needed.

When the software was installed, an option to install starter data was provided. If the person who
installed the software elected to include starter data, you can print out the chart of accounts and use
the printed copy as a basis for determining which accounts can be deleted.

» To print a chart of accounts

1. From the GLS Task Folders, click the Chart of Accounts tab and then select the Chart of
Accounts List icon.
2. On the Options tab, under Print Type, select Detail. A detail list will include the accounts that

journal entries can be posted to.
3. Click OK. Use the printed list to mark which accounts can be deleted.

» To delete an account

1. From the GLS Task Folders, click the Chart of Accounts tab and then select the Chart of
Accounts icon.
2. Highlight the account you want to delete.

3. dlick &

If there are no accounts in your chart of accounts (i.e., the person who installed the software did not
install the starter data), you can use the following procedure to get the sample chart of accounts.
This procedure walks you through manually copying the chart of accounts from the TUTOR folder to
your Current Working Directory.

» To get the sample chart of accounts

1. From the GLS menu, point to Help and select About GLS.

2. Make a note of the Current Working Directory.

3. Open Windows Explorer and navigate to the Current Working Directory noted in the previous

step.

Double-click the Tutor folder.

Click the Name column to sort the files in alpha order.

6. You need to copy the GSMSTR.DAT and G5MSTR.IDX file to the clipboard and paste them to
the Current Working Directory.

v b
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Scroll down and select the GSMSTR.DAT file.

Hold the shift key down and click the GSMSTR.IDX file.

Verify both the GSMSTR.DAT and G5MSTR.IDX files are selected.

Right-click the selected file block and select Copy to copy the files to the Windows
clipboard.

e. Navigate back to the Current Working Directory.

f.  Right-click the Current Working Directory and select Paste.

e n oo

7. After copying the files, run a Data File Integrity Check to verify there are no errors.
a. From the GLS Task Folder, click the Utilities/Maintenance Task Folder and then click
the Data File Integrity Check icon.
b. Click OK to the message.
c. Click OK to start the Data File Integrity Check.

A Little Background About Accounts
The Print Type and Account Type fields are the most important fields to understand.

Print Type |There are 4 different Print Types:

Detail Detail accounts are the accounts that journal entries are posted to.
Detail accounts are indented in the Chart of Accounts window.

Heading | Heading accounts are used to determine the beginning of a group of
detail accounts and can optionally print on the Balance Sheet or
Income Statements. Heading accounts are automatically paired with a
Total account and are shown as bold in the Chart of Account window.

Total Total accounts are used to determine the end of a group of detail
accounts and can optionally print a total line on the Balance Sheet or
Income Statement. Total accounts are automatically paired with a
Heading account and are shown as bold in the Chart of Accounts
window.

Comment | Comment accounts are used to print additional information on the
Balance Sheet or Income Statement.
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Account Type | There are 7 different Account Types.

Asset Asset accounts appear on the Balance Sheet and typically
have debit balances.

Liability Liability accounts appear on the Balance Sheet and
typically have credit balances.

Income Income accounts appear on the Income Statement and
typically have credit balances.

Expense Expense accounts appear on the Income Statement and
typically have debit balances.

Bank Account Bank Accounts are a type of asset account that can be
reconciled.

Credit Card Credit Card accounts are a type of liability account that

can be reconciled.

Retained Earnings | There can be only one Retained Earnings account. The
Retained Earnings account balance is calculated as Assets
minus Liabilities, plus or minus any journal entries posted
to the account.

Figure 52 shows the Chart of Accounts window. You can drag and drop accounts to their desired
position.

E Chart of Accounts E@
Search: Show Inactive
Description Account Type Account # Dept »
|Assel | __1000.00] 0 ]
Current Assets Assel 101000 0
Cash Asset 110000 0
Operating Account Bank Account 111000 0O
Money Market Bank Account 112000 O
Payrall Bank Account 113000 0
Trust Bank Account Bank Account 15000 0
Clignt Funds &ccount [accrual] Bank Account 116000 O
Total Cash Asset 119300 0
Chient/Employee Advances Asset 120000 0
Client Cost Advances Asset 121000 0
Employee Advances Azzet 122000 0
Total Client/Employee Advances Asset 122900 0
Accounts Receivable Asset 1230.00 99
Fee A/R - Firm Azset 124000 93
Expenze AR Aszet 125000 93
Advance &/R Asset 1260.00 93
Finance Charge &/R Azset 1270.00 93
Unapplied Payment /R Azzet 128000 939
Total Accounts Receivable Asset 1299.00 99
Work-In-Process Asset 1300.00 93
Faa WP . Firm P 19nnn 9a

Figure 52, GLS Chart of Accounts window

Double-clicking an account opens the Account Setup window. The Account Setup window has two
tabs, the Account tab and the Report Options tab as shown in Figure 53 and Figure 54.
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Account Setup - (i) | [ Account Setup - D |
Accourt | Report Options Accourt | Report Options
Account # 1m0.00 Accourt #: 110.00
IR SO < ting Accour] Description:  Operating Account
Department 0 - (Al Departments) Detail Report Options Summary Report Options
Display on Balance Sheet [ Display on Balance Sheet
Accourt Type: Balance Shest Account
Lines Before: None Lines Before: None
Prrt Type: Detai Underseare Nome Underscore None
Account Options Advanced Options
[T Accrual Accourt
Hlnacwe [invert Balance Type
Figure 53, Account tab of GLS Account Setup Figure 54, Report Options tab of GLS Account Setup

» To add a new account

1. From the GLS Task Folders, click the Chart of Accounts tab and then select the Chart of
Accounts icon.
In the Chart of Accounts window, highlight the account above the account you want to add.
aick L
Specify the account number you want to use and click OK.
The Account Setup window will be displayed.
a. Enter the account Description.
b. Specify the Account Type.
c. Specify the Print Type.
d. Specify any other settings.
6. Click Save.

v w N

Posting Beginning Balances

Beginning balances are transferred to General Ledger by posting journal entries. Before you can post
journal entries, your chart of accounts must be defined.

Determine Starting Date & Posting Date

Before posting beginning balances, you will need to determine your starting date, which is the first
day of the month that you want to begin using GLS. Then, when posting journal entries for
beginning balances, you will use the day prior to the starting date.

Examples
e If your starting date is April 1, then you will use a March 31 posting date.
e If your starting date is October 1, then you will use a September 30 posting date.
e If your starting date is January 1, 2014, then you will use a December 31, 2013 posting date.
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Post Journal Entries for Starting Balances
Once you have determined your starting date, you can post starting balances as follows.

e You will post a single transaction that includes a journal entry for each account.

e All journal entries must use the same date. Use the day prior to your starting date for your
posting date.

e Your accounts must be in balance before you can save the transaction.

Asset & Liability Accounts Use the account's closing balance as of the posting date.

e For example, if you want to begin using GLS in May 2014,
use April 30, 2014 for your posting date and the account's
closing balance as of April 30, 2014.

Income & Expense Accounts | Use the account's cumulative YTD balance as of the posting date.

e For example, if you want to begin using GLS in May 2014,
use April 30, 2014 for your posting date and the account's
cumulative YTD balance as of April 30, 2014.
Retained Earnings Account | Your retained earnings account may or may not require a journal
entry.

e If your retained earnings account started the year with a
zero balance, your debits and credits will be in balance and
no journal entry to the retained earnings account is
required.

e If your retained earnings account balance is carried over
from the previous year, you will need to post a journal
entry for the account balance as of the beginning of the
year. Use the same posting date as the other journal
entries. After making this journal entry, your debits and
credits should be in balance.

More Info: Detailed information regarding the Journal Entries program can be found in the
General Ledger Guide or in Help by pressing F1.

Once you have entered balances for all accounts in the transaction, save the transaction. You can
verify your balances by printing a Balance Sheet and Income Statement using the month of your
starting date for the Calendar Month to Print.
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Outstanding Checks and Deposits Note: Before performing your first reconciliation, you must
enter journal entries for any outstanding checks and deposits that were included in your starting
balance. You can do this now or later. Use the same account number for both the debit and credit
entry. For outstanding checks, mark the debit entry as Reconciled. For outstanding deposits, mark
the credit entry as Reconciled. You can enter all outstanding checks (or outstanding deposits) in a
single transaction or you can use separate transactions for each outstanding check (or deposit). If
you use the same transaction, you must use the same date.

Additional information regarding entering outstanding transactions, as well as the initial
reconciliation can be found in Knowledge Base article R11577, “Performing an Initial
Reconciliation in GLS (Ver. 17)" (support.Tabs3.com).
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Platinum & Tabs3 Connect

If you are using Platinum software, you will need to configure HotBackup and Tabs3 Connect. The
Installation Guide includes a great introduction to Platinum software and the various configuration
screens used.

Configuring HotBackup

Once the Platinum software has been installed, you can enable HotBackup, set up the HotBackup
schedule, and configure the e-mail messages you want sent when a HotBackup successfully
completes or does not complete. Detailed information on HotBackup can be found in the
Installation Guide and the Platinum Server Guide. Additionally, you can find detailed field level
information in System Configuration Help for the various windows. Knowledge Base article R11193,
HotBackup Overview, also includes detailed information regarding HotBackup.

Configuring Tabs3 Connect

Once Tabs3 Connect has been configured, you can designate which users can use Tabs3 Connect.
Detailed information on configuring Tabs3 Connect and enabling users can be found in the
Installation Guide and System Configuration Help. Knowledge Base article R11480, All About
Tabs3 Connect, includes comprehensive information about Tabs3 Connect.
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Configuring Advanced Features

Credit Card Processing

Tabs3 Billing and Tabs3 Trust Accounting allows credit card processing for payment transactions,
client funds deposit transactions, and trust account deposit transactions at the time of entry. Tabs3
credit card processing uses merchant accounts from TSYS™ Merchant Solutions (formerly First
National Merchant Solutions®). TSYS®™ Merchant Solutions is a top 10 payment processor with
more than 50 years of experience providing first-rate service and solutions to businesses across the
nation.

Configuring merchant accounts is done in Tabs3 Billing Customization and TAS Customization via
the Merchant Services tab as shown in the following figures.

Customnization [s E=8 ol 5 Customization N EI@
| Main_[ other Systems [ Options | Rates | Ciient Defauts | Merchant Services Merchart Services

Tabs3 has the abity o process crec card payments o he ine of ety gz s | ) N )

To sign up or leam more about Merchant Services, click the Leam More Trust Accounting has the ability to process credit card

butten. deposits at the time of entry. To sign up or lean more

about Merchant Services, click the Leam More button
Enable Credit Card Processing for Payments

Enable Credit Card Processing for Client Funds

Merchant Azcount Setup
Enable processing of Credit Card Deposits Account Setup
Merchant Accourts can be st up for the Fi, Client Location, and/or Primary
Timekeeper. I multiple merchant accounts are defined, Tabs3 will process credit card

paymentts based on the following order: Primary Timekeeper, Client Location, then Firm. Frint Merchant Account Setup Report ]

Merchant Account Setup

[ Print Merchant Account Setup Report ]

Figure 55, Merchant Services tab in Figure 56, Merchant Services tab in
Tabs3 Billing Customization TAS Customization

More Info: Complete details regarding Credit Card Processing can be found in the Tabs3 Credit
Card Processing Guide.

Document Management

PracticeMaster includes enhanced Document Management features that help your firm track all
types of documents. You can create a convention for document names and locations, and then let
PracticeMaster automatically name and file your documents. You can create your own document
types for use in classifying, naming and storing documents in a manner that meets your firm's needs.
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Check Out and Check In features let you check out documents to prevent others from editing them
while you are working on them. You can also create versions of documents, which enhances your
ability to track changes during the editing and review process. Instantly save and update managed
documents from Word, Adobe, Outlook, Excel, PowerPoint, WordPerfect, and Outlook e-mail
attachments. A powerful import feature lets you import entire groups of documents at one time
directly from Windows Explorer and organize them in PracticeMaster.

More Info: Complete information regarding Document Management in PracticeMaster can be
found in the Document Management Guide. Appendix A of this guide includes a Getting Started
Checklist.

Taskbill

Many larger corporations, particularly insurance companies, commonly require law firms to submit
their invoices in an electronic format that conforms to a specific format as required by an electronic
billing service. These formats have very specific and unique requirements regarding how the
information must be submitted. Tabs3 Taskbill software was designed to meet these specific
requirements and currently supports over 100 different formats. Knowledge Base article R10435,
Tabs3 Taskbill Product Information, includes information regarding the formats that Taskbill
supports.

Many company's formats require task based billing. Enabling task based billing for a client allows
you to enter phase and activity/expense codes when inputting fees and costs. These codes are based
on the Universal Task-Based Management system (or UTBMS).

More Info: Additional information regarding task based billing can be found in the Billing
Methods Guide.

More Info: Additional information regarding how to install and configure Taskbill can be found in
the Knowledge Base and in the Help provided with Taskbill.
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Administrative Maintenance

The following section of this guide includes best practices regarding general usage.

General Usage Tips

Use the following tips to keep the software running at its best.

Exit the Software Before Turning Off the Computer

It is important that all users exit the software properly before turning off the computer. You can use
any of the following methods to exit the software.

e From the File menu, click Exit

e Click the Close button on the title bar gﬂgj

Active User List

The Active User List (View | Active User List) shows which users are in the software. Managers can
select the All Systems check box to optionally view all users in all of the software. Additionally,
managers have the right to reset individual users.

E_j Active User List l\ l D |G
@ Detail () Suramany

User ID User Mame Spstem Computer Mame  Curent Activity -

Tabs3 &

DM DM Practicetd aster “WDAN Practicehd aster Spstem benu

DEBE DEB Trust Accounting “WDEB Trust Accounting System Menu

“DiAM D&M Accounts Payable SWDAN Yendor Information

< [ b
[] &l Systems [ Reset ] [ Close ] [ Help ]

Figure 57, Active User List window

Resetting Users

When a user exits the software properly, the Active User List is updated. If a users does not exit the
software properly, the user must be reset. For example, if a user's computer is accidentally
unplugged while the software is open, that user must be reset. That same user can reset himself, or a
manager can reset him. However, non-manager users cannot reset other users.
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Although it is necessary in certain circumstances to have to reset users, it should be the exception as
opposed to the rule. Users that are in the software should never be reset. Resetting users that are in
the software can cause data loss, data corruption, and fatal errors. Other users who attempt to use
the software before that user has been reset can encounter fatal errors when trying to use the
software. If it becomes necessary to reset a user, contact the user and ask them to log out. If the user
is unavailable, go to the user's computer and lose the program(s) yourself.

You can see which users have been reset by viewing the reset log file (View | Log Files | Reset Log).

More Info: Knowledge Base article R10789, Resetting Users, includes detailed information
regarding resetting users and how to reduce the frequency of resets.

Startup Options
The Tabs3 software includes various startup options that can be used when starting the software. We
recommend familiarizing yourself with the various options available.

One startup option that most firms like to implement is the abilityto bypass the User ID in the Logon
window. You can modify the desktop shortcuts to include the User ID so that the user does not have
to type in their User ID every time they start the software.

More Info: The Help for each Tabs3 product includes detailed information regarding startup
options.

Month-End/Year-End Procedures

There are several tasks that must be performed at month-end and year-end for the Tabs3 Billing,
General Ledger, Accounts Payable, and Trust Accounting software. Checklists with these monthly
tasks can be found in the Help and also in our Knowledge Base in the following articles.

R10429 |Year-End Overviews for Tabs3 Software Products
R11146 | Tabs3 Billing Year-End Overview

R11600 | General Ledger Software Year-End Overview
R11278 | Accounts Payable Software Year-End Overview
R10433 | Trust Accounting Software Year-End Overview

Backup Best Practices

Tabs3 software includes a built-in backup feature. In addition to using the built-in backup, it is
important that you implement another backup method. A thorough discussion of the backup
options can be found in Knowledge Base article R11213 - Backup Strategy.
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Integrity Check Programs

Tabs3 software includes built-in utility programs that check the integrity of the data. We recommend
that these programs be run on a monthly basis and also prior to all backups. In addition, these
programs should be run if a hardware failure occurs while using the software (i.e., power failure,
power surge, etc.).

Program Menu
Tabs3 Billing Utilities | Data File Integrity Check
Utilities | Archive Integrity Check
PracticeMaster | Utilities | Data File Integrity Check
Trust Accounting | Utilities | Data File Integrity Check
Accounts Payable  Utilities | Data File Integrity Check
General Ledger | Utilities | Data File Integrity Check

After the Data File Integrity Check completes, verify that there are zero errors. If errors are
encountered, run the Error Report and resolve the errors before continuing to use the software.

More Info: Knowledge Base article R11541, Data File Integrity Check Errors, includes detailed
information on how to resolve any data file integrity check errors that may occur. Likewise,
Knowledge Base article R10771, Data File Integrity Check Errors, includes detailed information on
how to resolve any data file integrity check errors that may occur.

Tracking Tools

Tabs3 software includes various tools to help you track software activity.

Verification Lists

Verification lists are lists of activity that has occurred.

Each user can run a list of all transactions that have been entered. For example, the Tabs3 Billing Fee
Verification file includes a list of all fee transactions that have been added, changed and deleted.
Users can review their own verification lists or they can submit them to an administrator for review
purposes.

More Info: Examples of the various verification lists are available in the Sample Reports.

More Info: Knowledge Base article R10793, All About Verification Lists, includes detailed
information regarding the various verification lists in Tabs3 software.
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Log Files

Log files track multiple activities in the Tabs3 software. Multiple log files are available for each
program. They can be very useful in tracking down the cause of errors and determining when

changes were made.

The following log files are maintained in the software for troubleshooting purposes and can be
accessed via the View menu by pointing to the Log Files menu option.

Error Log
(All Programs)

Reset Log
(All Programs)

Support Log
(All Programs)

Outlook Sync Billing Changes Log
(Tabs3 Billing)

Outlook Sync Log
(PracticeMaster)

Outlook Search Log
(PracticeMaster)

Tabs3 Connect Log
(System Configuration)
Tabs3 Connect Access Log

(System Configuration)

Submit Log Files

The Error Log tracks any fatal errors that occur in the
software.

The Reset Log tracks information regarding when users are
reset using the Active User List program.

The Support Log tracks various activities performed in the
software.

The Outlook Sync Billing Changes Log tracks changes to
Bill To contacts made by the Outlook Synchronization
process in PracticeMaster.

The Outlook Sync Log tracks information on the changes
made during the Outlook Synchronization process.

The Outlook Search Log stores any errors that occur while
PracticeMaster updates e-mail records in Outlook.

The Tabs3 Connect Log is a detailed log file used for
reviewing chronological Tabs3 Connect activity and
troubleshooting connection issues.

The Tabs3 Connect Access Log tracks user access to Tabs3
Connect and records occurrences of log ins, log outs, lock
outs, and downloads of documents and e-mail
attachments.

Menu: Help | Internet Resources | Submit Log Files

The Submit Log Files program (Figure 58) is used to provide log file information to Technical Support
for troubleshooting purposes via the Internet. Before the requested log files can be submitted, you
will be required to enter an Incident ID, which will be provided by the Technical Support
Representative with whom you are speaking.
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Ta zubmit error log information ta Tabs3 ¢ PracticeMaster Technical
Support, enter the Incident 1D provided to vou by the Support
Feprezentative and click Send.

Incident 10

|F any additional files were requested, click Advanced and select the
appropriate files.

Advanced Send

Figure 58, Submit Log Files window

Incident ID The Incident ID will be provided by the Support
Representative that you are speaking with on the phone.
The Incident ID will be a 4-character code. Until this field
is filled in, the Send button will remain unavailable.

The Advanced button opens the Advanced File Selection window, which allows you to select
additional log files to be submitted to Technical Support.

The Send button will submit all files that were selected in the Advanced File Selection window, but
only becomes available after the Incident ID has been entered.

History Tracking
History Tracking is an optional feature in PracticeMaster that can be used to track all additions and
changes to specific fields in a file. History Tracking does not track deletions.

By default, History Tracking is not enabled. When History Tracking is enabled, additional activity is
performed by PracticeMaster. PracticeMaster performs additional writing to the hard disk every time
a record is added or changed for any file that has a field configured to track history. Therefore, we
recommend enabling History Tracking for only those fields that require it.

How to Configure History Tracking
History tracking is configured at two levels—the system level and for each individual field.

» To configure History Tracking at the System Level

1. From PracticeMaster Task Folders, click the Maintenance tab, then click the Customization
icon.

2. Select the Use History Tracking check box.
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If you want to limit the size of the History Tracking file, select Limit history file size and
specify the maximum size (in megabytes) that you want to allow the History Tracking file to
reach.

Click OK to save the Customization settings.

» To configure History Tracking for an Individual Field

L

From PracticeMaster Task Folders, click the Maintenance tab, then click the File
Maintenance icon.

Click the + next to System Files or Areas of Practice to display the corresponding list(s) of
files.

Once you have selected the desired file, right-click the file and choose Edit Field Definitions.
...Or...
Alternatively, double-click the file and select the Field tab.

The File Definition window will be displayed. Highlight the field you want to change in the
Field IDs list.

Select the Track History check box.

Click Done to save the change.

Note: The Help | About PracticeMaster window indicates whether History Tracking is enabled,
the user defined maximum History File size, and the combined size of the current History Files.

Viewing the History File

Viewing the History File is accomplished via the Editor window.

» To view the History File

> wo N o

From the File menu, point to Open and select the file whose history you want to view.
From the List tab, highlight the desired record.
Right-click the highlighted record, point to Action and then select Display History.

If changes have been made, the View Record History window will be displayed allowing you
to browse through the changes. Otherwise, a message will displayed indicating history
tracking cannot be displayed.

When the History File Gets Too Large
The history for all configured fields is maintained in a single set of files named CMAUDIT.DAT and
CMAUDIT.IDX. Depending on which fields are using History Tracking, these files have the potential
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of becoming extremely large. Because of this, you have the ability to specify a maximum History File
Size. Once the files have reached their size limit, any data written to the History Tracking File will
begin replacing the oldest data to make room for the new data.

When the size of the CMAUDIT.DAT file is within 10% of the specified maximum size, a message will
be displayed when PracticeMaster is started. This message indicates that the maximum history
tracking file size will soon be reached. You can either increase the maximum file size or leave it at its
current size. If you leave the file at its current size, the message will be displayed again the next time
PracticeMaster is started. If you select the Do not show again check box, the message will not be
displayed again for you (unless the user profile is reset or you run the Reset Optional Messages
program).

Miscellaneous Notes
History tracking is available for all files whose file structure can be modified. However, history
tracking is not available for the following files:

Timekeeper File
Category File
Tcode File

Task Code File
User File

Text Macro File
Location File
eNote File
Secure Client File

Resources

There are many resources available to help you learn and use the software.

Guides & Quick Guides

There are multiple guides installed with the software. Select Help | Documentation for a list of all
available resources. The guides can also be accessed via our Web site at:

Tabs3.com/support/docs.html
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Sample Reports

Sample report packs are available for all software. These report packs includes examples of each
report in the software and include detailed information regarding each item on the report. Select
Help | Documentation for a list of all available resources. The sample reports can also be accessed
via our Web site at:

Tabs3.com/support/docs.html

Training Videos

Training videos are multimedia resources that walk you through Tabs3 Billing and PracticeMaster
features. Select Help | Training Videos to access the training video libraries. The training videos can
also be accessed via our Web site at:

Tabs3.com/videos

Knowledge Base

The Knowledge Base includes information regarding Tabs3 software products and is provided for
resellers, consultants, end-users and other third parties who work with Tabs3 software. It contains
extensive information on Error Troubleshooting, Networking & Windows Issues, "How To" articles
and product-related articles. The Knowledge Base requires Internet access. Select Help | Internet
Resources | Knowledge Base to access the Knowledge Base. The Knowledge Base can also be
accessed at:

support.Tabs3.com

Help

Help is installed with the software and is easily accessed by pressing F1, by clicking the & button,
or by selecting the Help | Help Topics menu option. Help includes detailed information regarding

==
L

specific programs. Clicking the & button opens Help for the window you are currently using. Many
times, reading the appropriate Help topic may be the fastest way to find your answer.
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Technical Support

Tabs3 provides some of the best technical support in the industry. Service to our customers is
extremely important to us--so much so that our motto is:

Reliable software. Trusted service.

Technical support is provided at no charge with a maintenance plan and is available from 8:00 a.m.
to 5:00 p.m. Central Time, Monday through Friday. If you have any questions, please feel free to call
our Technical Support staff at (402) 419-2210.

Tabs3 Resellers & Consultants

Tabs3 software products are available through a national network of over 250 resellers and
consultants. Those resellers and consultants are small independent firms that specialize in the sales,
installation, training and support of billing, financial, and practice management software for law
firms. By having resellers and consultants service all 50 states, you can work directly with a local
person familiar with Tabs3 software, who can provide personalized on-site installation, training, and
support services. Visit our Web site for a reseller near you or contact our Sales staff at (402) 419-2200.

Tabs3.com/resellers/resellers.html

Thank you for choosing Tabs3 software. We look forward to serving your practice management and
billing needs with reliable software and trusted service for many years to come. Let us know how we
can help you get started with Tabs3 and PracticeMaster.
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